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1
Product Description

The HP Compaq Business Notebook nx5000 Series and the 
Compaq Presario V1000 notebook PC offer advanced modularity, 
an Intel® Pentium® M or an Intel Celeron® M processor with 
64-bit architecture, an Intel Extreme Graphics 2 graphics 
controller with up to 64 MB of shared video memory, and 
extensive multimedia support.

HP Compaq Business Notebook nx5000 Series (Compaq Presario 
V1000 notebook PC appearance varies slightly).
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Product Description
1.1 Models
Notebook models are shown in Table 1-1, Table 1-2, and 
Table 1-3.

Table 1-1
HP Compaq Business Notebook nx5000

and Compaq Presario V1000 Notebook PC
Model Naming Conventions 

Key

Cnx U P 170 X5 60 y Ci 10 h XXXXXX-XXX

1 2 3 4 5 6 7 8 9 10 11

Key Description Options

1 Brand/Series 
designator

C = HP Compaq
P = Presario

nx5000 (all models)
V10xx

2 Graphics memory U = Shared memory architecture

3 Processor type P = Intel Pentium M
C = Intel Mobile Celeron

4 Processor speed 170 = 1.70 GHz
160 = 1.60 GHz
150 = 1.50 GHz

140 = 1.40 GHz
130 = 1.30 GHz
120 = 1.20 GHz

5 Display type/ 
size/resolution

X = XGA
Y = SXGA+WVA

5 = 15.0-inch
4 = 14.1-inch

6 Hard drive size 60 = 60 GB
40 = 40 GB

30 = 30 GB

7 Optical drive 
designator

Y = 24x DVD+RW/R 
and CD-RW Combo 
Drive
C = 24x CD-ROM Drive

W = 24x DVD/CD-RW 
Combo Drive
D = 8x/24x DVD-ROM 
Drive
1–2 Maintenance and Service Guide



Product Description
Key

Cnx U P 170 X5 60 y Ci 10 h XXXXXX-XXX

1 2 3 4 5 6 7 8 9 10 11

Key Description Options

8 Integrated 
communication/ 
wireless device

M = Modem
C = Combination 
modem + FE NIC
N = None

b = 802.11b
d = 802.11a/b/g
g = 802.11b/g 
i = 802.11b + 
Bluetooth®
j = 802.11b/g + 
Bluetooth
m = 802.11a/b/g + 
Bluetooth
N = None

9 RAM 12 = 128-MB
25 = 256-MB

51 = 512-MB
10 = 1,024-MB

10 Operating system P = Microsoft® Windows® XP 
Professional
H = Microsoft Windows XP 
Home
2 = Microsoft Windows 2000
L = Linux
F = FreeDOS

a = 1-year 
warranty on 
parts and labor
g= 4-year 
warranty on 
parts and labor
S = Special

11 SKU#

Table 1-1
HP Compaq Business Notebook nx5000

and Compaq Presario V1000 Notebook PC
Model Naming Conventions (Continued)
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Product Description
Table 1-2
HP Compaq Business Notebook nx5000 Models 

All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 P 140 X5 30 W Md 25 PaS

United States PD973US ABA

Cnx5000 U C 120 X4 30 C Cb 25 H

Taiwan DY824PA AB0

Cnx5000 U C 120 X4 30 C CN 25 2

Japan PB690PA ABJ

Cnx5000 U C 120 X4 30 C CN 25 H

Japan PB328PA ABJ

Cnx5000 U C 120 X4 30 C CN 25 P

Japan PB688PA ABJ

Cnx5000 U C 120 X4 30 D Cb 25 H

Taiwan DY825PA AB0

Cnx5000 U C 120 X4 30 D Cb 25 P

Taiwan DY826PA AB0

Cnx5000 U C 120 X4 30 W Cb 25 P

Japan PC993PA ABJ

Cnx5000 U C 120 X4 30 W CN 25 P

Japan PB691PA ABJ

Cnx5000 U C 120 X4 40 C Cb 51 H

Asia Pacific PC981PA UUF
1–4 Maintenance and Service Guide



Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U C 120 X4 40 C CN 25 P

Japan PB689PA ABJ

Cnx5000 U C 120 X4 40 W Cb 51 H

Australia DX925P ABG

Cnx5000 U C 120 X5 30 C CN 25 P

Brazil PA502A AC4

Cnx5000 U C 120 X5 30 D Cb 25 P

French Canada
Latin America

DH946U ABC
DH946U ABM

United States DH946U ABA

Cnx5000 U C 120 X5 40 W Cb 51 H

Australia PB324PA ABG

Cnx5000 U C 130 X4 30 C Cg 25 P

United States DV110U ABA

Cnx5000 U C 130 X4 30 C Cg 25 PgS

United States PE804UC ABA

Cnx5000 U C 130 X4 40 D CN 25 P

Australia PE734PA ABG

Cnx5000 U C 130 X4 40 N Cg 25 P

United States DV137U ABA

Cnx5000 U C 130 X5 40 W Cb 25 P

Australia PE735PA ABG

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U C 130 X5 40 W Cb 51 H

Australia PB707PA ABG

Cnx5000 U C 130 X5 40 W CN 51 P

Brazil PA498A AC4

Cnx5000 U P 140 X4 30 C Cb 12 LS

Thailand PC529PC AKL

Cnx5000 U P 140 X4 30 C Cb 25 H

Asia Pacific DY819PA UUF Taiwan DY827PA AB0

Cnx5000 U P 140 X4 30 C Cb 25 P

Asia Pacific
Hong Kong

DX905P UUF
DV616P AB5

Taiwan DY830PA AB0

Cnx5000 U P 140 X4 30 D Cb 25 F

United States PE776AA ABA

Cnx5000 U P 140 X4 30 D Cb 25 H

Asia Pacific DY822PA UUF Taiwan DY828PA AB0

Cnx5000 U P 140 X4 30 D Cb 25 P

Asia Pacific
French Canada
Latin America

DX373P UUF
DW804AA ABC
DW804AA ABM

Taiwan
United States

DW804AA AB0
DW804AA ABA

Cnx5000 U P 140 X4 30 W Cb 25 PS

Thailand PA094PC AKL

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 140 X4 40 C Cb 25 P

Thailand PA621PA AKL

Cnx5000 U P 140 X4 40 D Cb 25 H

Taiwan DY833PA AB0

Cnx5000 U P 140 X4 40 D Cb 25 P

People’s Republic of 
China

DV836P AB2 Taiwan DY872PA AB0
and
DY837PA AB0

Cnx5000 U P 140 X4 40 W Cb 25 H

Taiwan DY835PA AB0

Cnx5000 U P 140 X4 40 W Cb 25 LS

Thailand PC530PC AKL

Cnx5000 U P 140 X4 40 W Cb 25 P

Asia Pacific
Hong Kong

PA244PA UUF
DV617P AB5

People’s Republic 
of China

Taiwan

DV837P AB2

DY839PA AB0

Cnx5000 U P 140 X4 60 W Cb 51 P

Thailand PB703PA AKL
and
PB702PA AKL

Cnx5000 U P 140 X5 30 C Cb 25 H

Asia Pacific DY820PA UUF

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 140 X5 30 C Cb 25 P

Asia Pacific
Brazil
Latin America

DZ512PA UUF
PB451A AC4
PA501A ABM

Taiwan
United States

DY831PA AB0
PA501A ABA

Cnx5000 U P 140 X5 30 C CN 25 2

Japan DV834P ABJ

Cnx5000 U P 140 X5 30 C CN 25 P

Japan DV625P ABJ

Cnx5000 U P 140 X5 30 D Cb 25 H

Asia Pacific DY821PA UUF Taiwan DY829PA AB0

Cnx5000 U P 140 X5 30 D Cb 25 P

Asia Pacific
Latin America

DZ513PA UUF
PA500A ABM

Taiwan
United States

DY832PA AB0
PA500A ABA

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 140 X5 30 W Cb 25 H

Belgium
Czech Republic
Denmark
Europe International
France
Greece/Polish/ 

English
Germany
Hungary
Iceland
Israel
Italy

DU302A UUG
DU302A AKB
DU302A ABY
DU302A ABB
DU302A ABF
DU302A B1A

DU302A ABD
DU302A AKC
DU302A A2M
DU302A ABT
DU302A ABZ

The Netherlands
Norway
Poland
Portugal
Russia
Saudi Arabia
Slovenia
Spain
Sweden/Finland
Switzerland
Turkey
United Kingdom

DU302A ABH
DU302A ABN
DU302A AKD
DU302A AB9
DU302A ACB
DU302A ABV
DU302A AKN
DU302A ABE
DU302A AK8
DU302A UUZ
DU302A AB8
DU302A ABU

Cnx5000 U P 140 X5 30 W Cb 25 P

Belgium
Czech Republic
Denmark
Europe International
France
Greece/Polish/ 

English
Germany
Hungary
Iceland
Israel
Italy

DU303A UUG
DU303A AKB
DU303A ABY
DU303A ABB
DU303A ABF
DU303A B1A

DU303A ABD
DU303A AKC
DU303A A2M
DU303A ABT
DU303A ABZ

The Netherlands
Norway
Poland
Portugal
Russia
Saudi Arabia
Slovenia
Spain
Sweden/Finland
Switzerland
Turkey
United Kingdom

DU303A ABH
DU303A ABN
DU303A AKD
DU303A AB9
DU303A ACB
DU303A ABV
DU303A AKN
DU303A ABE
DU303A AK8
DU303A UUZ
DU303A AB8
DU303A ABU

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 140 X5 30 W Cb 51 P

Latin America PA497A ABM
and
PA499A ABM

United States PA497A ABA
and
PA499A ABA

Cnx5000 U P 140 X5 30 W Cg 25 P

Latin America PD366L ABM United States PD366L ABA

Cnx5000 U P 140 X5 40 C CN 25 P

Japan DV833P ABJ

Cnx5000 U P 140 X5 40 D Cb 25 H

Korea DZ845PA AB1 Taiwan DY834PA AB0

Cnx5000 U P 140 X5 40 D Cb 25 P

Brazil PB452A AC4 Taiwan DY838PA AB0

Cnx5000 U P 140 X5 40 W Cb 25 H

Asia Pacific
Hong Kong

DY823PA UUF
DV618P AB5

Korea
Taiwan

DZ846PA AB1
DY836PA AB0

Cnx5000 U P 140 X5 40 W Cb 25 P

Asia Pacific
Australia/New 

Zealand
Hong Kong

DX903P UUF
DV614P ABG

PA223PA AB5

Japan
Korea
Taiwan

DX366AA ABJ
PA217PA AB1
DY840PA AB0

Cnx5000 U P 140 X5 40 W Cb 25 PS

Australia PD642PC ABG

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 140 X5 40 W Cb 51 P

Asia Pacific
Belgium
French Canada

DW805AA UUF
DW806AA UUG
DW806AA ABC

Latin America

United States

PA496A ABM
and
DW80AA ABM
PA496A ABA
and
DW806AA ABA

Cnx5000 U P 140 X5 40 W Cb 51 PaS

United States PE688UC ABA

Cnx5000 U P 140 X5 40 W Cg 51 P

Latin America Pd364L ABM United States PD364L ABA

Cnx5000 U P 140 X5 40 W Ci 25 P

Asia Pacific
Europe International
France

PC979PA UUF
DW807AA ABB
DW807AA ABF

Germany
Italy
United Kingdom

DW807AA ABD
DW807AA ABZ
DW807AA ABU

Cnx5000 U P 140 X5 40 W Mg 25 PaS

United States PD931US ABA

Cnx5000 U P 140 Y5 30 D Ci 51 P

Italy DU411A ABZ

Cnx5000 U P 140 Y5 30 W CN 25 P

Japan DV835P ABJ

Cnx5000 U P 140 Y5 40 W Cb 51 H

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Korea PB744Pa AB1

Cnx5000 U P 150 S5 60 Y Ci 51 P

Australia/New 
Zealand

DX384P ABG

Cnx5000 U P 150 S5 60 Y Ci 51 PS

Australia PD641PC ABG

Cnx5000 U P 150 X4 30 C Cg 25 P

Hong Kong PB721PA AB5

Cnx5000 U P 150 X4 30 C CN 25 P

Japan PD677PA ABJ

Cnx5000 U P 150 X4 30 D Cg 25 P

Asia Pacific PE761Pa UUF

Cnx5000 U P 150 X4 30 D CN 51 H

Taiwan PB696PA AB0

Cnx5000 U P 150 X4 40 D Cb 25 H

People’s Republic of 
China

PD664PA AB2

Cnx5000 U P 150 X4 40 D Cb 25 P

People’s Republic of 
China

DV838P AB2

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 150 X4 40 D CN 25 P

People’s Republic of 
China

PD667Pa AB2

Cnx5000 U P 150 X4 40 W Cb 25 H

People’s Republic of 
China

PD665PA AB2

Cnx5000 U P 150 X4 40 W Cb 25 P

People’s Republic of 
China

PC986PA AB2

Cnx5000 U P 150 X4 40 W Cg 25 P

Thailand PE759PA AKL

Cnx5000 U P 150 X4 40 W CN 25 H

People’s Republic of 
China

PD668Pa AB2

Cnx5000 U P 150 X5 30 C Cb 25 P

Brazil PD362L AC4

Cnx5000 U P 150 X5 30 C CN 25 P

Japan PD678PA ABJ

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 150 X5 30 W Cg 25 H

Belgium
Denmark
Europe International
France
Germany
Greece/Polish/ 

English
Hungary
Iceland
Italian
Netherlands

DU396A UUG
DU396A ABY
DU396A ABB
DU396A ABF
DU396A ABD
DU396A B1A

DU396A AKC
DU396A A2M
DU396A ABZ
DU396A ABH

Norway
Poland
Portugal
Russian
Saudi Arabia
Slovenia
South Africa
Spain
Sweden/Finland
Switzerland
United Kingdom

DU396A ABN
DU396A AKD
DU396A AB9
DU396A ACB
DU396A ABV
DU396A AKN
DU396A ACQ
DU396A ABE
DU396A AK8
DU396A UUZ
DU396A ABU

Cnx5000 U P 150 X5 30 W Cg 25 P

Belgium
Denmark
Europe International
France
Germany
Greece/Polish/ 

English
Hungary
Iceland
Italy
Latin America
Netherlands

DU397A UUG
DU397A ABY
DU397A ABB
DU397A ABF
DU397A ABD
DU397A B1A

DU397A AKC
DU397A A2M
DU397A ABZ
PD367L ABM
DU397A ABH

Norway
Poland
Portugal
Russian
Saudi Arabia
Slovenia
South Africa
Spain
Sweden/Finland
Switzerland
United Kingdom
United States

DU397A ABN
DU397A AKD
DU397A AB9
DU397A ACB
DU397A ABV
DU397A AKN
DU397A ACQ
DU397A ABE
DU397A AK8
DU397A UUZ
DU397A ABU
PD367L ABA

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 150 X5 40 C Cb 25 H

Korea PA218PA AB1

Cnx5000 U P 150 X5 40 C CN 25 P

Japan PD679PA ABJ

Cnx5000 U P 150 X5 40 D Cb 25 H

Korea PA219PA AB1

Cnx5000 U P 150 X5 40 D Cb 25 P

Brazil PD361L AC4

Cnx5000 U P 150 x5 40 D Cg 25 P

United States DV111U ABA

Cnx5000 U P 150 X5 40 N Cg 25 P

United States DV138U ABA

Cnx5000 U P 150 X5 40 W Cb 25 H

Korea PA220PA AB1

Cnx5000 U P 150 x5 40 W Cb 25 P

Asia Pacific DX904P UUF
and
DX374P UUF

Korea
Thailand

PA221PA AB1
DY870PA AKL

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 150 x5 40 W Cb 51 H

Belgium
Czech Republic
Denmark
Europe International
France
Greece/Polish/ 

English
Germany
Hungary
Iceland
Israel
Italy

DU304A UUG
DU304A AKB
DU304A ABY
DU304A ABB
DU304A ABF
DU304A B1A

DU304A ABD
DU304A AKC
DU304A A2M
DU304A ABT
DU304A ABZ

The Netherlands
Norway
Poland
Portugal
Russia
Saudi Arabia
Slovenia
Spain
Sweden/Finland
Switzerland
Turkey
United Kingdom

DU304A ABH
DU304A ABN
DU304A AKD
DU304A AB9
DU304A ACB
DU304A ABV
DU304A AKN
DU304A ABE
DU304A AK8
DU304A UUZ
DU304A AB8
DU304A ABU

Cnx5000 U P 150 X5 40 W Cb 51 LS

Asia Pacific PC637PC UUF

Cnx5000 U P 150 X5 40 W Cb 51 P

Asia Pacific PB704PA UUF

Cnx5000 U P 150 X5 40 W Cd 25 H

Korea PB745PA AB1

Cnx5000 U P 150 X5 40 W Cg 25 P

Hong Kong PB720PA AB5

Cnx5000 U P 150 X5 40 W Cg 51 P

Latin America PD365L ABM

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 150 X5 40 W Cg 51 P

United States PD365L ABA

Cnx5000 U P 150 X5 40 W Ci 25 PS

Australia PE784PC ABG

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
Maintenance and Service Guide 1–17



Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 150 x5 40 W Ci 51 P

Belgium

Czech Republic
Denmark
Europe International
France

Greece/Polish/ 
English

Germany

Hungary
Iceland
Israel
Italy

The Netherlands

DU305T UUG
and
DU305A UUG
DU305A AKB
DU305A ABY
DU305A ABB
DU305T ABF
and
DU305A ABF
DU305T B1A
and
DU305A B1A
DU305T ABD
and 
DU305A ABD
DU305A AKC
DU305A A2M
DU305A ABT
DU305T ABZ
and
DU305A ABZ
DU305T ABH
and
DU305A ABH

Norway

Poland
Portugal
Russia

Saudi Arabia
Slovenia
Spain

Sweden/Finland

Switzerland

Turkey
United Kingdom

DU305T ABN
and 
DU305A ABN
DU305A AKD
DU305A AB9
DU305T ACB
and
DU305A ACB
DU305A ABV
DU305A AKN
DU305T ABE
and
DU305A ABE
DU305T AK8
and
DU305A AK8
DU305T UUZ
and
DU305A UUZ
DU305A AB8
DU305T ABU
and 
DU305A ABU

Cnx5000 U P 150 X5 40 W Cj 25 H

Hong Kong PB722PA AB5

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 150 X5 60 W Cb 25 P

People’s Republic of 
China

PC987PA AB2

Cnx5000 U P 150 x5 60 W Cb 51 P

Asia Pacific DZ496PA UUF

Cnx5000 U P 150 X5 60 W Ci 51 P

Asia Pacific PC980PA UUF

Cnx5000 U P 150 x5 60 Y Cb 51 P

Australia/New 
Zealand

DV615P ABG

Cnx5000 U P 150 Y5 30 W CN 51 P

Japan PD680PA ABJ

Cnx5000 U P 150 Y5 40 D CN 51 P

Korea PB743PA AB1

Cnx5000 U P 150 Y5 40 N Ci 51 P

Germany DU344A ABD

Cnx5000 U P 150 Y5 40 W Cb 25 P

Korea DV839P AB1

Cnx5000 U P 150 Y5 40 W Ci 25 H

Hong Kong DV619P AB5

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 150 Y5 60 W Cb 51 H

Korea PC969PA AB1

Cnx5000 U P 150 Y5 60 W Cd 10 H

Korea PC967PA AB1

Cnx5000 U P 160 X4 40 C Ci 51 H

Poland DU407S AKD

Cnx5000 U P 160 X4 40 D Cb 25 H

Latin America PA503A ABM United States PA503A ABA

Cnx5000 U P 160 X4 40 D Cb 25 P

People’s Republic of 
China

PD666PA AB2

Cnx5000 U P 160 X5 40 D CN 51 H

United States DV149US ABA

Cnx5000 U P 160 X5 40 W Cb 51 P

Asia Pacific DX375P UUF Thailand DY871PA AKL

Cnx5000 U P 160 X5 40 W Cg 25 P

Asia Pacific
Hong Kong

PE892PA UUF
PB723PA AB5

Thailand PE760PA AKL

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 160 X5 40 W Cj 51 P

Belgium

Denmark
Europe International
France

Germany

Greece/Polish/ 
English

Hungary
Iceland
Italy

Netherlands

DU399T UUG
and
DU399A UUG
DU399A ABY
DU399A ABB
DU399T ABF
and
DU399A ABF
DU399T ABD
and
DU399T AB8
and
DU399A ABD
DU399A B1A

DU399A AKC
DU399A A2M
DU399T ABZ
and
DU399A ABZ
DU399T ABH
and
DU399A ABH

Norway

Poland
Portugal
Russian

Saudi Arabia
Slovenia
South Africa
Spain

Sweden/Finland

Switzerland

United Kingdom

DU399T ABN
and
DU399A ABN
DU399A AKD
DU399A AB9
DU399T ACB
and
DU399A ACB
DU399A ABV
DU399A AKN
DU399A ACQ
DU399T ABE
and
DU399A ABE
DU399T AK8
and
DU399A AK8
DU399T UUZ
and
DU399A UUZ
DU399T ABU
and
DU399A ABU

Cnx5000 U P 160 X5 40 W Cm 51 P

Latin America PA495A ABM United States PA495A ABA

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 160 X5 40 W CN 25 P

United States DV142US ABA

Cnx5000 U P 160 X5 40 W CN 51 P

United States PF001US ABA

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 160 X5 40 Y Cg 51 H

Belgium

Denmark
Europe International
France

Germany

Greece/Polish/ 
English
Hungary
Iceland
Italy

Netherlands

DU398A UUG
and
DU398T UUG
DU398A ABY
DU398A ABB
DU398T ABF
and
DU398A ABF
DU398T ABD
and
DU398A ABD
DU398A B1A

DU398A AKC
DU398A A2M
DU398T ABZ
and
DU398A ABZ
DU398T ABH
and
DU398A ABH

Norway

Poland
Portugal
Russian

Saudi Arabia
Slovenia
South Africa
Spain

Sweden/Finland

Switzerland

United Kingdom

DU398T ABN
and
DU398A ABN
DU398A AKD
DU398A AB9
DU398T ACB
and
DU398A ACB
DU398A ABV
DU398A AKN
DU398A ACQ
DU398T ABE
and
DU398A ABE
DU398T AK8
and
DU398A AK8
DU398T UUZ
and
DU398A UUZ
DU398T ABU
and
DU398A ABU

Cnx5000 U P 160 X5 60 W Cb 25 H

Korea DV842P AB1

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 160 X5 60 W Cb 25 P

Thailand DV880P AKL

Cnx5000 U P 160 X5 60 Y Cb 51 P

Brazil PB453A AC4

Cnx5000 U P 160 X5 60 Y Ci 51 H

Belgium
Czech Republic
Denmark
Europe International
France
Greece/Polish/ 

English
Germany
Hungary
Iceland
Israel
Italy

DU306A UUG
DU306A AKB
DU306A ABY
DU306A ABB
DU306A ABF
DU306A B1A

DU306A ABD
DU306A AKC
DU306A A2M
DU306A ABT
DU306A ABZ

The Netherlands
Norway
Poland
Portugal
Russia
Saudi Arabia
Slovenia
Spain
Sweden/Finland
Switzerland
Turkey
United Kingdom

DU306A ABH
DU306A ABN
DU306A AKD
DU306A AB9
DU306A ACB
DU306A ABV
DU306A AKN
DU306A ABE
DU306A AK8
DU306A UUZ
DU306A AB8
DU306A ABU

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 160 X5 60 Y Ci 51 P

Australia/New 
Zealand

Belgium
Czech Republic
Denmark
Europe International
France
Greece/Polish/ 

English
Germany
Hungary
Iceland
Israel
Italy
Korea
Latin America
The Netherlands
Norway

DX367AA ABG

DU307A UUG
DU307A AKB
DU307A ABY
DU307A ABB
DU307A ABF
DU307A B1A

DU307A ABD
DU307A AKC
DU307A A2M
DU307A ABT
DU307A ABZ
DX367AA AB1
PA494A ABM
DU307A ABH
DU307A ABN

Poland
Portugal
Russia
Saudi Arabia
Slovenia
Spain

Sweden/Finland

Switzerland

Turkey
United Kingdom
United States

DU307A AKD
DU307A AB9
DU307A ACB
DU307A ABV
DU307A AKN
DX367AA ABE
and
DU307A ABE
DX367AA AK8
and
DU307A AK8
DX367AA UUZ
and
DU307A UUZ
DU307A AB8
DU307A ABU
PA494A ABA

Cnx5000 U P 160 Y5 40 W Mb 51 PS

United States PB657US ABA

Cnx5000 U P 160 Y5 60 W Cb 25 P

Korea DV841P AB1

Cnx5000 U P 160 Y5 60 W Ci 51 P

United States DY520AA ABA

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 160 Y5 60 Y Ci 51 P

United States DX368AA ABA

Cnx5000 U P 160 Y5 60 Y Cj 51 P

Latin America PD363L ABM United States PD363L ABA

Cnx5000 U P 170 X4 30 C CN 25 2

Japan DV623P ABJ

Cnx5000 U P 170 X4 30 C CN 25 H

Japan DV620P ABJ

Cnx5000 U P 170 X4 30 C CN 25 P

Japan DV621P ABJ

Cnx5000 U P 170 X4 30 W CN 25 P

Japan DV624P ABJ

Cnx5000 U P 170 X4 40 C CN 25 P

Japan DV622P ABJ

Cnx5000 U P 170 X5 60 W Cb 51 P

Asia Pacific DX376P UUF

Cnx5000 U P 170 X5 60 Y Cb 51 P

Brazil PD360L AC4

Cnx5000 U P 170 X5 60 Y Cj 51 P

Greece/Polish/ 
English

DU400A B1A

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
All HP Compaq Business Notebook nx5000 models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- or 3-year warranty on parts and labor, varying by model

Cnx5000 U P 170 Y5 60 W Cd 25 H

Korea DZ515PA AB1

Cnx5000 U P 170 Y5 60 W Cd 25 P

Korea DZ514PA AB1

Table 1-2
HP Compaq Business Notebook nx5000 Models (Continued)
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Product Description
Table 1-3
Compaq Presario V1000 Notebook PC Models 

All Compaq Presario V1000 notebook PC models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1-year warranty on parts and labor

PV1001AP U P 140 X4 30 D Cb 25 H

Asia Pacific DY202P UUF Thailand DY202P AKL

PV1002AP U P 150 Y5 40 W Ci 25 H

Hong Kong DY203P AB5

PV1003AP U P 140 X5 40 W Cb 25 H

Asia Pacific DY204P UUF Hong Kong DY204P AB5

PV1004AP U P 140 X4 30 W Cb 25 H

Hong Kong DY205P AB5

PV1004XX U P 140 X4 30 W Cb 25 H

Asia Pacific DZ543AA UUF

PV1005AP U C 120 X4 30 D Cb 25 H

People’s Republic of 
China

DY206P AB2

PV1006AP U C 130 X4 40 D Cb 25 H

People’s Republic of 
China

DY207P AB2

PV1007AP U P 140 X4 40 D Cb 25 H

People’s Republic of 
China

DY208P AB2

PV1008AP U P 140 X4 40 W Cb 25 H

Asia Pacific DY209P UUF People’s Republic of 
China

DY209P AB2
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Product Description
All Compaq Presario V1000 notebook PC models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1-year warranty on parts and labor

PV1009AP U P 140 X5 40 W Cb 25 H

Peoples Republic of 
China

DY210P AB2

PV1010AP U P 150 X5 40 D Cb 25 H

People’s Republic of 
China

DY211P AB2

PV1011AP U P 150 X5 40 W Cb 25 H

People’s Republic of 
China

DY212P AB2

PV1011AP U P 150 X5 40 W Cb 25 H

Thailand DY212P AKL

PV1012AP U C 120 X4 30 D Cb 25 H

Taiwan DY213P AB0

PV1013AP U P 140 X4 30 C Cb 25 H

Taiwan DY214P AB0

PV1014AP U P 140 X4 30 D Cb 25 H

Taiwan DY215P AB0

PV1015AP U P 140 X4 40 D Cb 25 H

Taiwan DY216P AB0

PV1016AP U P 140 X4 40 W Cb 25 H

Taiwan DY217P AB0

Table 1-3
Compaq Presario V1000 Notebook PC Models (Continued)
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Product Description
All Compaq Presario V1000 notebook PC models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1-year warranty on parts and labor

PV1017AP U P 140 X5 30 C Cb 25 H

Taiwan DY218P AB0

PV1018AP U P 140 X5 30 D Cb 25 H

Taiwan DY219P AB0

PV1019AP U P 140 X5 40 D Cb 25 H

Taiwan DY220P AB0

PV1020AP U P 140 X5 40 W Cb 25 H

Taiwan DY221P AB0

PV1021AP U P 140 X4 30 D Cb 12 H

Asia Pacific DY222P UUF

PV1022AP U P 150 X5 40 Y Cb 25 H

Asia Pacific DY223P UUF

PV1023AP U P 160 X5 60 W Cb 51 H

Asia Pacific DY224P UUF

PV1024AP U P 140 X5 30 D Cb 25 H

Asia Pacific DY225P UUF

PV1025AP U P 140 X4 30 C Cb 25 H

Asia Pacific DY226P UUF

PV1026AP U P 140 X5 30 C Cb 25 H

Asia Pacific DY227P UUF

Table 1-3
Compaq Presario V1000 Notebook PC Models (Continued)
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Product Description
All Compaq Presario V1000 notebook PC models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1-year warranty on parts and labor

PV1027AP U P 150 X4 40 W Cb 25 H

Asia Pacific DY228P UUF

PV1028AP U P 150 X5 40 Y Cb 25 H

Thailand DY229P AKL

PV1029AP U C 120 X4 30 D Cb 25 H

Taiwan DY230PA AB0

PV1030AP U P 140 X4 30 W Cb 25 H

Taiwan DZ847PA AB0

PV1031AP U C 130 X5 60 W Cb 25 H

Korea DZ848PA AB1

PV1032AP U P 160 X5 40 W Cb 25 H

Korea DZ849PA AB1

PV1033AP U P 160 Y5 60 W Cb 25 H

Korea DZ850PA AB1

PV1034AP U P 170 X5 60 W Cb 51 H

Korea DZ851PA AB1

PV1035AP U P 160 X5 40 W Cb 51 H

Korea DZ852PA AKL

PV1036AP U P 150 X5 40 Y Ci 25 H

Hong Kong DZ853PA AB5

Table 1-3
Compaq Presario V1000 Notebook PC Models (Continued)
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Product Description
All Compaq Presario V1000 notebook PC models feature:

■ TouchPad pointing device

■ Video memory

■ 8- or 6-cell lithium ion (Li-Ion) battery pack

■ 1- year warranty on parts and labor

PV1037AP U P 140 X5 60 W Cb 25 H

Thailand DZ854PA AKL

PV1038AP U P 140 X4 40 W Ci 25 H

Asia Pacific DZ855PA UUF

PV1039AP U P 150 X4 40 W Ci 25 H

Asia Pacific DZ856PA UUF

PV1040AP U P 150 X5 40 W Ci 25 H

Asia Pacific DZ857PA UUF

PV1041AP U P 160 X5 60 W Ci 51 H

Asia Pacific DZ858PA UUF

PV1042AP U P 150 X5 40 W Cj 25 H

Hong Kong DZ859PA AB5

PV1043XX U P 150 X5 60 W Cb 51 H

Korea DZ544AA AB1

Table 1-3
Compaq Presario V1000 Notebook PC Models (Continued)
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Product Description
1.2 Features
■ Intel Pentium M 2.0-, 1.8-, 1.7-, 1.6-, 1.5-, or 1.4-GHz 

processors, with 1.0-MB or 2.0-MB L2 cache, varying 
by notebook model 
- or - 
Intel Celeron M 1.4-, 1.3-, or 1.2-GHz processor, with 
512-KB L2 cache, varying by notebook model

■ 15.0-inch SXGA+ WVA (1400 × 1050) display with over 
16.7 million colors 
- or - 
15.0- or 14.1-inch XGA (1024 × 768) TFT displays with 
over 16.7 million colors, varying by notebook model

■ Intel Extreme Graphics 2 graphics controller with up to 
64 MB of shared video memory, limited to 32 MB of shared 
video memory on models with 128 MB system memory

■ 60-, 40-, or 30-GB high-capacity hard drive, varying by 
notebook model

■ 128-MB DDR synchronous DRAM (SDRAM) at 266 MHz, 
expandable to 2.0 GB

■ Microsoft® Windows® XP Professional, Windows XP 
Home, or Windows 2000, varying by notebook model

■ Full-size Windows keyboard with integrated numeric keypad

■ TouchPad pointing device

■ Integrated Secure Digital (SD) Memory Card slot

■ MultiBay device support

■ Integrated 10/100 BASE-T Ethernet local area network 
(LAN) NIC with RJ-45 connector

■ Integrated wireless support for Bluetooth®, LAN, Mini PCI 
802.11a/b/g WLAN devices, and 802.11b WLAN PC cards

■ Support for 2 Type I or Type II or one Type III PC Card 
with support for both 32-bit (CardBus) and 16-bit PC Cards

■ Infrared port
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Product Description
■ External 65-watt AC adapter with power cord

■ 8-cell 4.4 Ah Li-Ion battery pack 
-or- 
6-cell 4.4 Ah Li-Ion battery pack

■ Stereo speakers

■ Support for the following devices in the MultiBay:

❏ 24X CD-ROM Drive

❏ 24X DVD/CD-RW Combo Drive

❏ 8X/24X DVD-ROM Drive

❏ 24X DVD+RW/R and CD-RW Combo Drive

❏ 8-cell 3.6 Ah Li-Ion battery pack

■ Connectors for:

❏ RJ-11 (modem)

❏ RJ-45 network interface card (NIC)

❏ Universal Serial Bus (USB) v. 2.0

❏ S-Video

❏ Serial device

❏ Parallel device

❏ External monitor

❏ DC power

❏ Docking station

❏ Microphone

❏ Stereo speaker/headphone

❏ One Type III or 2 Type I/II PC Cards

❏ SD Cards
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Product Description
1.3 Clearing a Password
If the notebook you are servicing has an unknown password, 
follow these steps to clear the password. These steps also 
clear CMOS.

1. Prepare the notebook for disassembly (Section 5.3).

2. Remove the real time clock (RTC) battery (Section 5.18).

3. Wait approximately 5 minutes.

4. Replace the RTC battery and reassemble the notebook.

5. Connect AC power to the notebook. Do not reinsert any 
battery packs at this time.

6. Turn on the notebook.

All passwords and all CMOS settings will have been cleared.
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Product Description
1.4 Power Management
The notebook comes with power management features that 
extend battery operating time and conserve power. The 
notebook supports the following power management features:

■ Standby

■ Hibernation

■ User customization of settings

■ Hotkeys for setting level of performance

■ Display switch standby/resume

■ Power/Standby button

■ Advanced Configuration and Power Interface  
(ACPI) compliance
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Product Description
1.5 External Components
The external components on the front and right side of the 
notebook are shown below and described in Table 1-4.

Front and Right-Side Components
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Product Description
Table 1-4
Front and Right-Side Components 

Item Component Function

1 Infrared port Provides wireless communication between 
the notebook and an optional IrDA-compliant 
device.

2 Mute button On: Mutes the system volume. A light comes 
on when the button is pushed in and the 
sound is muted.

3 Volume control buttons Increase and decrease system volume. 
Press the volume up button to increase 
sound. Press the volume down button 
to decrease sound.

4 Stereo speakers (2) Produce stereo sound.

5 Display release latch Opens the notebook.

6 Battery bay Holds the primary battery.

7 PC Card eject buttons Release PC Card devices from the 
PC Card slots.

8 PC Card slots (2) Support optional Type I, Type II, or Type III 
32-bit (CardBus) or 16-bit PC Cards.

9 Secure Digital (SD) 
Memory Card slot

Accepts SD Cards and MultiMedia Cards.

10 RJ-11 (modem) jack Connects a modem cable.

11 Bluetooth compartment Holds a Bluetooth wireless device.

✎ Bluetooth is not supported in all 
countries.

12 Security cable slot Attaches an optional security cable to 
the notebook.

✎ The purpose of security solutions is 
to act as a deterrent. These solutions 
do not prevent the product from being 
mishandled or stolen.
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Product Description
The notebook rear panel and left-side components are shown 
below and described in Table 1-5.

Rear and Left Components

Table 1-5
Rear and Left-Side Components 

Item Component Function

1 Vent Allows airflow to cool internal components.

2 AC power connector Connects an AC adapter, an optional 
Automobile Power Adapter/Charger, or 
an optional Aircraft Power Adapter.

3 Serial connector Connects an optional serial device.

4 Parallel connector Connects an optional parallel device, such 
as an external diskette drive bay or a printer.
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Product Description
5 S-Video connector Connects an optional S-Video device, such 
as a television, VCR, camcorder, overhead 
projector, or video capture card.

6 External monitor 
connector

Connects an optional external monitor 
or overhead projector.

7 1394 connector Connects an optional IEEE-1394 compliant 
device to the notebook.

8 RJ-45 (network) jack Connects a network cable.

9 USB connectors (2) Connect optional USB 1.1- and 
2.0-compliant devices to the notebook, 
using a standard USB cable.

10 Headphone jack Produces system sound when connected 
to optional powered stereo speakers, 
headphones, headset, or television audio.

11 Microphone jack Connects an optional monaural microphone.

12 Hard drive bay Holds the primary hard drive.

13 MultiBay device slot Holds a MultiBay device.

Table 1-5
Rear and Left-Side Components (Continued)

Item Component Function
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Product Description
The notebook wireless antennae are shown below and described 
in Table 1-6.

Wireless Antennae Locations

Table 1-6
Wireless Antennae

Component Description

Wireless antennae (2) Transmit wireless data.

Å Exposure to Radio Frequency 
Radiation. 
The radiated output power of this 
device is below the FCC radio 
frequency exposure limits. 
Nevertheless, the device should 
be used in such a manner that 
the potential for human contact 
during normal operation is 
minimized. To avoid the 
possibility of exceeding the FCC 
radio frequency exposure limits, 
human proximity to the antenna 
should not be less than 20 cm 
(8 inches) during normal 
operation, including when the 
notebook display is closed.
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Product Description
The notebook keyboard components are shown below and 
described in Table 1-7.

Keyboard Components
1–42 Maintenance and Service Guide



Product Description
Table 1-7
Keyboard Components 

Item Component Function

1 Windows logo key Displays the Windows Start menu.

2 fn key Executes frequently used system functions 
when pressed in combination with 
another key.

3 caps lock key Enables caps lock and turns on the caps 
lock light.

4 f1 through f12 function 
keys

Perform system and application tasks. When 
combined with the fn key, the function keys f1 
and f3 through f12 perform additional tasks 
as hotkeys.

5 num lock key Enables numeric lock and the internal 
keypad.

6 Embedded numeric 
keypad

Operates as a standard external numeric 
keypad.

7 Cursor control keys Move the cursor around the screen.

8 Windows 
applications key

Displays a shortcut menu for items beneath 
the pointer.
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Product Description
The notebook top components are shown below and described in 
Table 1-8.

Top Components

Table 1-8
Top Components 

Item Component Function

1 Num lock light On: Num lock is on or the embedded 
numeric keypad is enabled.

2 Caps lock light On: Caps lock is on.

3 Scroll lock light On: Scroll lock is on.
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4 Display lid switch* ■ If the notebook is closed while on, 
turns off the display.

■ If the notebook is opened while on, 
turns on the display.

5 Power button* When the notebook is: 
■ Off, press and release to turn on the 

notebook.

■ In Standby, press and release to exit 
Standby.

■ In Hibernation, press and release to 
exit Hibernation.

If the system has stopped responding and 
Windows shutdown procedures cannot be 
used, press and hold for 5 seconds to turn 
off the notebook.

6 QuickLock button Disables the keyboard and pointing device 
and clears the display.

7 Wireless on/off button Enables and disables the optional integrated 
wireless device(s) on the notebook.

✎ When using the wireless on/off button 
to enable integrated WLAN or 
Bluetooth, first ensure that WLAN or 
Bluetooth has been enabled in the 
software and that the wireless on/off 
light is on before attempting to make a 
connection.

*This table describes default settings. For information about changing the 
functions of the display lid switch and power button and about using Standby 
and Hibernation, refer to the “Power” chapter in the Software Guide on the 
Documentation Library CD.

Table 1-8
Top Components (Continued)

Item Component Function
Maintenance and Service Guide 1–45



Product Description
Top Components (Continued)

Table 1-8
Top Components (Continued)

Item Component Function

8 Presentation Mode 
button

Alternates between presentation modes.

9 TouchPad Moves the pointer and selects or activates 
items on the screen.

10 Left and right TouchPad 
buttons

Function like the left and right buttons on 
an external mouse.

11 MultiBay light On: A device in the MultiBay is being 
accessed.

12 Hard drive light On: Hard drive in the hard drive bay is 
being accessed.
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13 Battery light On: A battery pack is charging.
Blinking: A battery pack that is the only 
available power source has reached a 
low-battery condition. When the battery 
reaches a critical low-battery condition, the 
battery light begins blinking more quickly.
Off: AC power is applied with battery pack 
either fully charged or not installed, or no 
AC power is applied.

14 Power/Standby light On: Power is turned on.
Blinking: Notebook is in Standby. The 
Power/Standby light also blinks when a 
battery pack that is the only available 
power source reaches a critical low-battery 
condition. The light goes off when the 
system enters Hibernation or shuts down.

15 Wireless on/off light On: An optional integrated wireless device 
has been enabled.

Table 1-8
Top Components (Continued)

Item Component Function
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The external components on the bottom of the notebook are 
shown below and described in Table 1-9. 

Bottom Components

Table 1-9
Bottom Components 

Item Component Function

1 Intake vent Allows airflow to cool internal 
components.

Ä To prevent overheating, do 
not obstruct vents. Using the 
notebook on a soft surface, 
such as a pillow, blanket, rug, 
or thick clothing, may block 
airflow.

2 Bluetooth compartment Holds an optional Bluetooth device.

✎ Bluetooth is not supported in 
all countries.
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3 Port replicator docking latches Secures the notebook to an 
optional Port Replicator or 
advanced Port Replicator.

4 Docking connector Connects the notebook to an 
optional Port Replicator or 
advanced Port Replicator.

5 Hard drive cover screw Secures the hard drive cover.

6 Hard drive bay Holds the internal hard drive.

7 Hard drive security screw Secures the hard drive.

8 MultiBay release latch Releases the MultiBay device.

9 MultiBay Holds the MultiBay device.

10 Keyboard access screws (2) Secure the keyboard.

Table 1-9
Bottom Components (Continued)

Item Component Function
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11 Mini PCI compartment Holds an optional wireless LAN 
device.

✎ To prevent an unresponsive 
system and the display of a 
warning message, install only 
a Mini PCI device authorized 
for use in your notebook by 
the governmental agency 
that regulates wireless 
devices in your country. If 
you install a device and then 
receive a warning message, 
remove the device to restore 
notebook functionality. Then 
contact Customer Care.

12 Battery bay Holds the primary battery pack.

13 Battery release latch Releases a battery pack from the 
battery bay.

14 Secure Digital (SD) Memory 
Card slot

Accepts SD Cards and MultiMedia 
Cards.

Table 1-9
Bottom Components (Continued)

Item Component Function
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1.6 Design Overview
This section presents a design overview of key parts and features 
of the notebook. Refer to Chapter 3, “Illustrated Parts Catalog,” 
to identify replacement parts, and Chapter 5, “Removal and 
Replacement Procedures,” for disassembly steps.

The system board provides the following device connections:

■ Memory module

■ Mini PCI communications device

■ Hard drive

■ Display

■ Keyboard and TouchPad

■ Audio

■ Intel Pentium M or Intel Mobile Celeron processor

■ Fan

■ PC Card

Ä
CAUTION: To properly ventilate the notebook, allow at least a 7.6-cm 
(3-inch) clearance on all sides of the notebook.

The notebook uses an electric fan for ventilation. The fan is 
controlled by a temperature sensor and is designed to come on 
automatically when high temperature conditions exist. These 
conditions can be caused by high external temperatures, heavy 
system power consumption, certain power management/battery 
conservation configurations, battery fast charging, and some 
software applications. Exhaust air is displaced through the 
ventilation grill located on the notebook rear panel.
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2
Troubleshooting

Å
WARNING: Only authorized technicians trained by HP should 
repair this equipment. All troubleshooting and repair procedures are 
detailed to allow only subassembly/module-level repair. Because of the 
complexity of the individual boards and subassemblies, do not attempt 
to make repairs at the component level or modifications to any printed 
wiring board. Improper repairs can create a safety hazard. Any 
indication of component replacement or printed wiring board 
modification may void any warranty or exchange allowances.

2.1 Computer Setup and Diagnostics 
Utilities
The notebook features 2 system management utilities:
■ Computer Setup—A system information and customization 

utility that can be used even when your operating system is 
not working or will not load. This utility includes settings that 
are not available in Microsoft Windows.

■ Diagnostics for Windows—A system information and 
diagnostic utility that is used within the Windows operating 
system. Use this utility whenever possible to
❏ Display system information.
❏ Test system components.
❏ Troubleshoot a device configuration problem in 

Windows XP Professional or Windows XP Home.

✎ It is not necessary to configure a device connected to a USB 
connector on the notebook or to an optional Port Replicator.
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Using Computer Setup

Information and settings in Computer Setup are accessed from 
the File, Security, or Advanced menus.

1. Turn on or restart the notebook. Press f10 while the 
F10 = ROM-Based Setup message is displayed in the 
lower left corner of the screen.

❏ To change the language, press f2.

❏ To view navigation information, press f1.

❏ To return to the Computer Setup menu, press esc.

2. Select the File, Security, or Advanced menu.

3. To close Computer Setup and restart the notebook:

❏ Select File > Save Changes and Exit and press enter.

-or-

❏ Select File > Ignore Changes and Exit and press enter.

4. When you are prompted to confirm your action, press f10.
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Selecting from the File Menu

Table 2-1
File Menu

Select To Do This

System Information ■ View identification information about the 
notebook, a Port Replicator, and any battery 
packs in the system.

■ View specification information about the 
processor, memory and cache size, and 
system ROM.

Save to Floppy Save system configuration settings to a diskette.

Restore from Floppy Restore system configuration settings from 
a diskette.

Restore Defaults Replace configuration settings in Computer Setup 
with factory default settings. Identification 
information is retained.

Ignore Changes and Exit Cancel changes entered during the current 
session, then exit and restart the notebook.

Save Changes and Exit Save changes entered during the current session, 
then exit and restart the notebook.
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Selecting from the Security Menu

Table 2-2
Security Menu

Select To Do This

Administrator password Enter, change, or delete an Administrator 
password. 

Power-On password Enter, change, or delete a power-on password. 

DriveLock passwords Enable/disable DriveLock; change a DriveLock 
User or Master password. 

✎ DriveLock Settings are accessible only 
when you enter Computer Setup by turning 
on (not restarting) the notebook.

SmartCard passwords Enable/disable support for Smart Card
passwords.

✎ This feature is supported by only certain 
Smart Card Readers.

Device security Enable/disable devices in the system. Enable NIC 
for inclusion in MultiBoot.

System IDs Enter identification numbers for the notebook, 
a Port Replicator, and all battery packs in the 
system.
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Selecting from the Tools Menu

Selecting from the Advanced Menu

Table 2-3
Tools Menu

Select To Do This

HDD Self-Test options Run a quick comprehensive self test on hard 
drives in the system that support the test 
features.

Battery Status View identification and charge information about 
the primary or MultiBay battery packs when they 
are in the system.

Table 2-4
Advanced Menu 

Select To Do This

Language Change the Computer Setup language.

Boot Options Enable/disable:
■ QuickBoot, which starts the notebook more 

quickly by eliminating some startup tests. 
(If you suspect a memory failure and want 
to test memory automatically during startup, 
disable QuickBoot).

■ MultiBoot, which sets a startup sequence that 
can include most bootable devices and media 
in the system.
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Device Options ■ Enable/disable the embedded numeric keypad 
at startup.

■ Enable/disable multiple standard pointing 
devices at startup. (To set the notebook to 
support only a single, usually nonstandard, 
pointing device at startup, select Disable).

■ Enable/disable USB legacy support for a 
USB keyboard. (When USB legacy support 
is enabled, the keyboard works even when 
a Windows operating system is not loaded).

■ Set an optional external monitor or overhead 
projector connected to a video card in a Port 
Replicator as the primary device. (When the 
notebook display is set as secondary, the 
notebook must be shut down before it is 
undocked from a Port Replicator).

■ Change the parallel port mode from Enhanced 
Parallel Port (EPP, the default setting) to 
standard, bi-directional EPP, or Enhanced 
Capabilities Port (ECP).

■ Set video-out mode to NTSC (default), PAL, 
NTSC-J, or PAL-M.*

■ Enable/disable all settings in the Intel 
SpeedStep window. (When Disable is selected, 
the notebook runs in Battery Optimized mode).

Table 2-4
Advanced Menu (Continued)

Select To Do This
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Device Options (continued) ■ Specify how the notebook recognizes multiple 
identical Port Replicators that are identically 
equipped. Select Disable to recognize the 
Port Replicators as a single Port Replicator; 
select Enable to recognize the Port Replicators 
individually, by serial number.

■ Enable/disable the reporting of the processor 
serial number by the processor to the software.

*Video modes vary even within regions. However, NTSC is common in North 
America; PAL in Europe, Africa, and the Middle East; NTSC-J in Japan; and 
PAL-M in Brazil. Other South and Central American regions can use NTSC, 
PAL, or PAL-M.

Table 2-4
Advanced Menu (Continued)

Select To Do This
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2.2 Using Diagnostics for Windows
When you access Diagnostics for Windows, a scan of all system 
components is displayed on the screen before the diagnostics 
window opens.

You can display more or less information from anywhere within 
Diagnostics for Windows by selecting Level on the menu bar.

Diagnostics for Windows is designed to test HP and Compaq 
notebook components. If other components are tested, the results 
might be inconclusive.

Obtaining, Saving, or Printing 
Configuration Information

1. Access Diagnostics for Windows by selecting Start > 
Settings > Control Panel > Diagnostics for Windows.

2. Select Categories, then select a category from the 
drop-down list.

❏ To save the information, select File > Save As.

❏ To print the information, select File > Print.

3. To close Diagnostics for Windows, select File > Exit.
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Obtaining, Saving, or Printing Diagnostic 
Test Information

1. Access Diagnostics for Windows by selecting Start > 
Settings > Control Panel > Diagnostics for Windows.

2. Select the Test tab.

3. In the scroll box, select the category or device you want 
to test.

4. Select a test type:

❏ Quick Test—Runs a quick, general test on each device 
in a selected category.

❏ Complete Test—Performs maximum testing on each 
device in a selected category.

❏ Custom Test—Performs maximum testing on a 
selected device.

◆ To run all tests for your selected device, select the 
Check All button.

◆ To run only the tests you select, select the Uncheck 
All button, then select the check box for each test 
you want to run.

5. Select a test mode:

❏ Interactive Mode—Provides maximum control over 
the testing process. You determine whether the test 
was passed or failed. You might be prompted to insert 
or remove devices.

❏ Unattended Mode—Does not display prompts. If errors 
are found, they are displayed when testing is complete.
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6. Select the Begin Testing button.

7. Select a tab to view a test report:

❏ Status tab—Summarizes the tests run, passed, and failed 
during the current testing session.

❏ Log tab—Lists tests run on the system, the number of 
times each test has run, the number of errors found on 
each test, and the total run time of each test.

❏ Error tab—Lists all errors found in the notebook, along 
with the corresponding error codes.

8. Select a tab to save the report:

❏ Log tab—Select the Save button.

❏ Error tab—Select the Save button.

9. Select a tab to print the report:

❏ Log tab—Select File > Save As, then print the file 
from your folder.
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2.3 Troubleshooting Flowcharts
Table 2-4 

Troubleshooting Flowchart Overview

Flowchart 2.1—Initial Troubleshooting

Flowchart 2.2—No Power, Part 1

Flowchart 2.3—No Power, Part 2

Flowchart 2.4—No Power, Part 3

Flowchart 2.5—No Power, Part 4

Flowchart 2.6—No Video, Part 1

Flowchart 2.7—No Video, Part 2

Flowchart 2.8—Nonfunctioning Port Replicator (if applicable)

Flowchart 2.9—No Operating System (OS) Loading

Flowchart 2.10—No OS Loading, Hard Drive, Part 1

Flowchart 2.11—No OS Loading, Hard Drive, Part 2

Flowchart 2.12—No OS Loading, Hard Drive, Part 3

Flowchart 2.13—No OS Loading, Diskette Drive

Flowchart 2.14—No OS Loading, CD-ROM or DVD-ROM Drive

Flowchart 2.15—No Audio, Part 1

Flowchart 2.16—No Audio, Part 2

Flowchart 2.17—Nonfunctioning Device

Flowchart 2.18—Nonfunctioning Keyboard

Flowchart 2.19—Nonfunctioning Pointing Device

Flowchart 2.20—No Network/Modem Connection
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Flowchart 2.1—Initial Troubleshooting
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Flowchart 2.2—No Power, Part 1
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Flowchart 2.3—No Power, Part 2
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Flowchart 2.4—No Power, Part 3
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Flowchart 2.5—No Power, Part 4
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Flowchart 2.6—No Video, Part 1
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Flowchart 2.7—No Video, Part 2
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Flowchart 2.8—Nonfunctioning Port Replicator 
(if applicable)
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Flowchart 2.9—No Operating System (OS) Loading
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Flowchart 2.10—No OS Loading, Hard Drive, Part 1
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Flowchart 2.11—No OS Loading, Hard Drive, Part 2
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Flowchart 2.12—No OS Loading, Hard Drive, Part 3
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Flowchart 2.13—No OS Loading, Diskette Drive
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Flowchart 2.14—No OS Loading, CD-ROM or 
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Troubleshooting
Flowchart 2.15—No Audio, Part 1
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Troubleshooting
Flowchart 2.16—No Audio, Part 2
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Flowchart 2.17—Nonfunctioning Device
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Troubleshooting
Flowchart 2.18—Nonfunctioning Keyboard
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Troubleshooting
Flowchart 2.19—Nonfunctioning Pointing Device
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Troubleshooting
Flowchart 2.20—No Network/Modem Connection
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3
Illustrated Parts Catalog

This chapter provides an illustrated parts breakdown and a 
reference for spare part numbers and option part numbers.

3.1 Serial Number Location
When ordering parts or requesting information, provide the 
notebook serial number and model number located on the 
bottom of the notebook.

Serial Number Location
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Illustrated Parts Catalog
3.2 Notebook Major Components

Notebook Major Components
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Illustrated Parts Catalog
Table 3-1
Spare Parts: Notebook Major Components

Item Description
Spare Part 
Number

1 Display assemblies

for use with HP Compaq Business Notebook nx5000
14.1-inch, TFT, XGA
15.0-inch, TFT, XGA
15.0-inch, TFT, SXGA+WVA

for use with Compaq Presario V1000 notebook PC
14.1-inch, TFT, XGA
15.0-inch, TFT, XGA
15.0-inch, TFT, SXGA+WVA

353384-001
353385-001
353386-001

359916-001
359917-001
359918-001

Miscellaneous Plastics Kit (includes the following 
components)

353393-001

2a
2b
2c
2d
2e
2f
2g
2h

Left and right display hinge covers
Memory shield
Keyboard plate
Speaker assembly
Bluetooth compartment cover
PC Card slot space savers (2)
Battery bezel
Mini PCI compartment cover
Not Shown 

RTC Battery 
Left and right display hinges 
Left and right display hinge screw caps 
Display rubber bumpers 
Notebook feet (4)
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Notebook Major Components
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Illustrated Parts Catalog
Table 3-1
Spare Parts: Notebook Major Components (Continued)

Item Description
Spare Part 
Number

3 Keyboards (include pointing stick)

Brazil
Czech 

Republic
Denmark
European 
France
French 

Canada
Germany
Hungary
Iceland
India
International
Israel
Italy
Japan

344390-201
344390-221 

344390-081
344390-A41
344390-051
344391-121 

344390-041
344390-211
344390-DD1
344390-D61
344390-B31
344390-BB1
344390-061
344390-291

Korea
Latin America
Norway
Portugal
Russia
Saudi Arabia
Slovenia
Spain
Sweden/Finland
Switzerland
Taiwan
Thailand
Turkey
United Kingdom
United States

344390-AD1
344390-161
344390-091
344390-131
344390-251
344390-171
344390-BA1
344390-071
344390-B71
344390-BG1
344390-AB1
344390-281
344390-141
344390-031
344390-001

4 Hard drives

60-GB (5400-rpm)
60-GB (4200-rpm)
40-GB (5400-rpm)
40-GB (4200-rpm)
30-GB (4200-rpm)

344406-001
360291-001
344405-001
359108-001
344404-001

5 Top Cover (includes TouchPad)
for use with HP Compaq Business Notebook 
nx5000
for use with Compaq Presario V1000 notebook PC

353387-001 

359919-001
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Notebook Major Components
3–6 Maintenance and Service Guide



Illustrated Parts Catalog
Table 3-1
Spare Parts: Notebook Major Components (Continued)

Item Description
Spare Part 
Number

6 MultiBay devices

24X CD-ROM Drive
8X/24X DVD-ROM Drive
4X DVD+RW/R and CD-RW Combo Drive
24X DVD/CD-RW Combo Drive
Diskette drive
8-cell, prismatic, 3.6-Ah, 52-Wh battery pack

228746-001
251292-001
344256-001
346789-001
241955-001
267747-001

7 Modem board (includes cables) 325521-001

8 Mini PCI communications cards

802.11a/b/g WLAN card
802.11b/g WLAN card

325525-001
325526-001

Wireless LAN cards

802.11b (MOW)
802.11b (ROW)

345641-001
345640-001

9 Base enclosure, with speakers 353388-001

10 System board 353390-001

11 LED switch cover

for use with HP Compaq Business Notebook nx5000
for use with Compaq Presario V1000 notebook PC

353389-001
359920-001

12 Bluetooth wireless communications board

With cable 
Without cable

348277-001
348276-001

13 Bottom board 353392-001

14 Fan assembly 345065-001

15 Heat sink 344410-001
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Notebook Major Components
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Illustrated Parts Catalog
Table 3-1
Spare Parts: Notebook Major Components (Continued)

Item Description
Spare Part 
Number

16 Processors

Intel Celeron M processor, 1.4-GHz
Intel Celeron M processor, 1.3-GHz
Intel Celeron M processor, 1.2-GHz
Intel Pentium M processor (2-MB L2 cache), 2.0-GHz
Intel Pentium M processor (2-MB L2 cache), 1.8-GHz
Intel Pentium M processor (2-MB L2 cache), 1.7-GHz
Intel Pentium M processor (2-MB L2 cache), 1.6-GHz
Intel Pentium M processor (2-MB L2 cache), 1.5-GHz
Intel Pentium M processor (1-MB L2 cache), 1.7-GHz
Intel Pentium M processor (1-MB L2 cache), 1.6-GHz
Intel Pentium M processor (1-MB L2 cache), 1.5-GHz
Intel Pentium M processor (1-MB L2 cache), 1.4-GHz

359637-001
356599-001
356598-001
353395-001
345857-001
356597-001
356596-001
359636-001
340165-001
319777-001
347253-001
319775-001

17 Memory modules, 266-MHz

1024-MB DDR
512-MB DDR
256-MB DDR
128-MB DDR

336579-001
336578-001
336577-001
336576-001

18 Battery packs

6-cell, Li-Ion, 4.4-Ah, 48-Wh
8-cell, Li-Ion, 4.4-Ah, 63-Wh

346886-001
338669-001

Not shown
LED board (with cable) 353391-001
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Illustrated Parts Catalog
3.3 Miscellaneous Plastics 
Kit Components

Miscellaneous Plastics Kit Components

Table 3-2
Miscellaneous Plastics Kit Components

Spare Part Number 353393-001 

Item Description

1 Left and right display hinges

2 Keyboard plate

3 Mini PCI compartment cover

4 RTC Battery

5 Rubber bumpers for side of display (2)

6 Rubber bumpers for top of display (3)

7 Left and right display hinge screw caps (2)
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Illustrated Parts Catalog
8 Speaker assembly

9 Memory shield

10 Left and right display hinge covers (2)

11 PC Card slot space savers (2)

12 Battery bezel

13 Bluetooth compartment cover

14 Notebook feet

Table 3-2
Miscellaneous Plastics Kit Components

Spare Part Number 353393-001 (Continued)

Item Description
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3.4 Hard Drives and MultiBay Devices

Table 3-3
Hard Drives and MultiBay Devices

Spare Part Information 

Item Description
Spare Part 
Number

1 Hard drives (include hard drive bezel and frame)

60-GB (5400-rpm)
60-GB (4200-rpm)
40-GB (5400-rpm)
40-GB (4200-rpm)
30-GB (4200-rpm)

344406-001
360291-001
344405-001
359108-001
344404-001

2 MultiBay drives

24X CD-ROM Drive
8X/24X DVD-ROM Drive
4X DVD+RW/R and CD-RW Combo Drive
24X DVD/CD-RW Combo Drive
Diskette drive

228746-001
251292-001
344256-001
346789-001
241955-001

3 MultiBay battery pack 267747-001
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3.5 Miscellaneous

Table 3-4
Miscellaneous (not illustrated)

Spare Part Information 

Description
Spare Part 
Number

3-wire power cords

Australia
Brazil
Denmark
Europe/ 

Middle East/ 
Africa

Israel

246959-011
246959-201
246959-081
246959-021 
 

246959-BB1

Italy
Japan
Korea
Switzerland
United Kingdom
United States

246959-061
246959-291
246959-AD1
246959-AG1
246959-031
246959-001

65-watt AC adapter 239704-001

Carrying cases

Leather, top load, Samsung
Leather, top load, SG
Nylon, top load, Samsung
Nylon, top load, SG
Nylon, entry level

325817-001
325817-002
325815-001
325815-002
325814-001

Port Replicators

Advanced Port Replicator
Simple Port Replicator

339096-001
339097-001
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Security card 345856-001

Screw Kit (includes the following screws; refer to 
Appendix C, “Screw Listing,” for more information on 
screw specifications and usage.)

353394-001

■ Phillips PM3.0×4.0 screw

■ Phillips PM3.0×3.5 screw

■ Phillips PM2.5×11.0 screw

■ Phillips PM2.5×9.0 screw

■ Phillips PM2.5×7.0 screw

■ Phillips PM2.5×3.5 screw

■ Phillips PM2.0×5.0 screw

■ Phillips PM2.0×3.0 screw

■ Phillips PM1.5×3.0 screw

■ Torx T8M2.5×5.5 screw

■ Torx T8M2.5×5.0 screw

■ Torx T8M2.5×3.5 
flat-head screw

■ Torx T5M3.0×4.0 screw

■ Hex M2.5×9.0 screw

■ Hex M2.0×10.0 alignment pin

USB mouse, carbon 164999-001

Table 3-4
Miscellaneous (not illustrated)

Spare Part Information (Continued)

Description
Spare Part 
Number
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4
Removal and Replacement 

Preliminaries

This chapter provides essential information for proper and safe 
removal and replacement service.

4.1 Tools Required
You will need the following tools to complete the removal and 
replacement procedures:

■ Magnetic screwdriver

■ Phillips P0 screwdriver

■ 5.0-mm socket for system board standoffs

■ Flat-bladed screwdriver

■ Tool kit (includes connector removal tool, loopback plugs, 
and case utility tool)
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Removal and Replacement Preliminaries
4.2 Service Considerations
The following sections include some of the considerations that 
you should keep in mind during disassembly and assembly 
procedures.

✎ As you remove each subassembly from the notebook, place 
the subassembly (and all accompanying screws) away from 
the work area to prevent damage.

Plastic Parts

Using excessive force during disassembly and reassembly can 
damage plastic parts. Use care when handling the plastic parts. 
Apply pressure only at the points designated in the maintenance 
instructions.

Cables and Connectors

Ä
CAUTION: When servicing the notebook, ensure that cables are 
placed in their proper locations during the reassembly process. 
Improper cable placement can damage the notebook.

Cables must be handled with extreme care to avoid damage. 
Apply only the tension required to unseat or seat the cables 
during removal and insertion. Handle cables by the connector 
whenever possible. In all cases, avoid bending, twisting, or 
tearing cables. Ensure that cables are routed in such a way that 
they cannot be caught or snagged by parts being removed or 
replaced. Handle flex cables with extreme care; these cables 
tear easily.
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Removal and Replacement Preliminaries
4.3 Preventing Damage to 
Removable Drives
Removable drives are fragile components that must be handled 
with care. To prevent damage to the notebook, damage to a 
removable drive, or loss of information, observe the following 
precautions:

■ Before removing or inserting a hard drive, shut down the 
notebook. If you are unsure whether the notebook is off or 
in Hibernation, turn the notebook on, then shut it down.

■ Before removing a diskette drive or optical drive, ensure that 
a diskette or disc is not in the drive. Ensure that the optical 
drive tray is closed.

■ Before handling a drive, ensure that you are discharged of 
static electricity. While handling a drive, avoid touching the 
connector.

■ Handle drives on surfaces that have at least one inch of 
shock-proof foam.

■ Avoid dropping drives from any height onto any surface.

■ After removing a hard drive, a CD-ROM drive, or a diskette 
drive, place it in a static-proof bag.

■ Avoid exposing a hard drive to products that have magnetic 
fields, such as monitors or speakers.

■ Avoid exposing a drive to temperature extremes or liquids.

■ If a drive must be mailed, place the drive in a bubble pack 
mailer or other suitable form of protective packaging and 
label the package “Fragile: Handle With Care.”
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4.4 Preventing Electrostatic Damage
Many electronic components are sensitive to electrostatic 
discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits 
provide some protection, but in many cases the discharge contains 
enough power to alter device parameters or melt silicon junctions.

A sudden discharge of static electricity from a finger or other 
conductor can destroy static-sensitive devices or microcircuitry. 
Often the spark is neither felt nor heard, but damage occurs.

An electronic device exposed to electrostatic discharge might not 
be affected at all and can work perfectly throughout a normal life 
cycle. Or the device might function normally for a while, then 
degrade in the internal layers, reducing its life expectancy.

4.5 Packaging and Transporting 
Precautions
Use the following grounding precautions when packaging and 
transporting equipment:

■ To avoid hand contact, transport products in static-safe 
containers, such as tubes, bags, or boxes.

■ Protect all electrostatic-sensitive parts and assemblies with 
conductive or approved containers or packaging.

■ Keep electrostatic-sensitive parts in their containers until 
the parts arrive at static-free workstations.

■ Place items on a grounded surface before removing them 
from their containers.

■ Always be properly grounded when touching a sensitive 
component or assembly.
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■ Store reusable electrostatic-sensitive parts from assemblies 
in protective packaging or nonconductive foam.

■ Use transporters and conveyors made of antistatic belts and 
roller bushings. Ensure that mechanized equipment used for 
moving materials is wired to ground and that proper materials 
are selected to avoid static charging. When grounding is not 
possible, use an ionizer to dissipate electric charges.

4.6 Notebook Precautions
Use the following grounding precautions with notebooks:

■ Cover the notebook with approved static-shielding material 
(refer to Table 4-2 Static-Shielding Materials).

■ Use a wrist strap connected to a properly grounded work 
surface and use properly grounded tools and equipment.

■ Use conductive field service tools, such as cutters, 
screwdrivers, and vacuums.

■ When using fixtures that must directly contact dissipative 
surfaces, use only fixtures made of static-safe materials.

■ Keep the work area free of nonconductive materials, such 
as ordinary plastic assembly aids and Styrofoam.

■ Handle electrostatic-sensitive components, parts, and 
assemblies by the case or PCM laminate. Handle these 
items only near static-free notebooks.

■ Avoid contact with pins, leads, or circuitry.

■ Turn off power and input signals before inserting or 
removing connectors or test equipment.
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4.7 Grounding Equipment and 
Methods
Grounding equipment must include either a wrist strap or a 
foot strap with a grounded notebook.

■ When seated, wear a wrist strap connected to a grounded 
system. Wrist straps are flexible straps with a minimum of 
one megohm ±10% resistance in the ground cords. To 
provide proper ground, wear a strap snugly against the skin 
at all times. On grounded mats with banana-plug connectors, 
connect a wrist strap with alligator clips.

■ When standing, use foot straps and a grounded floor mat. 
Foot straps (heel, toe, or boot straps) can be used while 
standing and are compatible with most types of shoes 
or boots. On conductive floors or dissipative floor mats, 
use foot straps on both feet with a minimum of one-megohm 
resistance between the operator and ground. To be effective, 
the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing 
electrostatic damage includes:

■ Antistatic tape

■ Antistatic smocks, aprons, and sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Nonconductive foam

■ Static-dissipative tables or floor mats with hard ties to 
the ground

■ Field service kits

■ Static awareness labels

■ Material-handling packages

■ Nonconductive plastic bags, tubes, or boxes

■ Metal tote boxes

■ Electrostatic voltage levels and protective materials
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Table 4-1 shows how humidity affects the electrostatic voltage 
levels generated by different activities.

Table 4-2 lists the shielding protection provided by antistatic bags 
and floor mats.

Table 4-1
Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V  5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

✎ A product can be degraded by as little as 700 volts.

Table 4-2
Static-Shielding Materials

Material Use Voltage Protection Level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V



5
Removal and Replacement 

Procedures

This chapter provides removal and replacement procedures.

There are 62 screws, standoffs, and pins that must be loosened, 
removed, or replaced when servicing the notebook. Make special 
note of each screw size and location during removal and 
replacement.

Refer to Appendix C, “Screw Listing,” for detailed information 
on removable screw, standoff, and pin sizes, locations, and usage.
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Removal and Replacement Procedures
5.1 Serial Number
When ordering parts or requesting information, provide the 
notebook serial number and model number located on the 
bottom of the notebook.

Serial Number Location
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Removal and Replacement Procedures
5.2 Disassembly Sequence Chart
Use the chart below to determine the section number to be 
referenced when removing notebook components.

Disassembly Sequence Chart 

Section Description # of Screws Removed

5.3 Preparing the Notebook for Disassembly

Battery pack
Hard drive

0
2 to remove, 
6 to disassemble

5.4 Notebook Feet 0

Section Description
# of Screws 
Removed

5.5 Mini PCI Communications Board 1 captive screw

WARNING: To prevent an unresponsive system 
and the display of a warning 
message, install only a Mini PCI 
device authorized for use in your 
notebook by the governmental agency 
that regulates wireless devices in your 
country. If you install a device and 
then receive a warning message, 
remove the device to restore 
notebook funtionality. Then contact 
Customer Care.

0

5.7 Bluetooth Wireless Communications 
Board

2
1 captive screw

5.8 Keyboard 2

5.9 Switch Cover 2

5.10 Modem Board 2

5.11 Memory Module 0

5.12 Keyboard Plate 0
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Removal and Replacement Procedures
5.3 Preparing the Notebook for 
Disassembly
Before you begin any removal or installation procedures:

1. Shut down the notebook. If you are not sure whether the 
notebook is off or in Hibernation, turn the computer on 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the notebook.

3. Disconnect the power cord.

5.13 Fan Assembly 2

5.14 Heat Sink 4

5.15 Processor 1 locking screw

5.16 Display Assembly 4

5.17 Top Cover 17

5.18 RTC Battery 0

5.19 Speakers 1

5.20 LED Board 1

5.21 Bottom Board 2

5.22 System Board 10 screws,
2 standoffs

Disassembly Sequence Chart (Continued)
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Removal and Replacement Procedures
4. Remove the battery pack:

a. Turn the notebook upside down, with the front panel 
toward you.

b. Slide and hold the battery release latch 1 toward the back 
of the notebook.

c. Use the notch in the battery pack to slide the battery 
pack 2 away from the notebook.

d. Remove the battery pack.

Removing the Battery Pack

Spare Part Number Information

Battery packs

6-cell, Li-Ion, 4.4-Ah, 48-Wh
8-cell, Li-Ion, 4.4-Ah, 63-Wh

346886-001
338669-001
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Removal and Replacement Procedures
5. Remove the battery bezel by sliding it down and off of the 
battery pack.

✎ The battery bezel is included in the Miscellaneous Plastics Kit, 
spare part number 353393-001.

Removing the Battery Bezel

Reverse the above procedure to install the battery pack and 
battery bezel.
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Removal and Replacement Procedures
6. Remove the hard drive by following these steps:

a. Turn the notebook upside down, with the rear panel 
toward you.

b. Remove the PM2.5×4.0 retaining screw 1 that secures the 
hard drive door to the notebook.

c. Remove the PM3.0×3.0 hard drive security screw 2 that 
secures the hard drive to the notebook.

d. Lift the hard drive cover 3 and swing it back.

Removing the Hard Drive Screws

Spare Part Number Information

Hard drives (include hard drive frame and connector)

60-GB (5400-rpm)
60-GB (4200-rpm)
40-GB (5400-rpm)
40-GB (4200-rpm)
30-GB (4200-rpm)

344406-001
360291-001
344405-001
359108-001
344404-001
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Removal and Replacement Procedures
e. Use the Mylar tab 1 to pull the hard drive 2 out of 
the bay.

f. Remove the hard drive.

Removing the Hard Drive
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Removal and Replacement Procedures
Ä
CAUTION: The hard drive should be disassembled only if it is 
damaged and must be repaired. Unnecessary disassembly of the 
hard drive can result in damage to the hard drive and loss of 
information.

g. Remove the two PM3.0×3.5 screws 1 and the two 
T5M3.0×4.0 screws 2 that secure the hard drive to the 
hard drive frame.

h. Use a 4.0-mm socket to remove the two M2.0×10.0 
alignment pins 3 that secure the hard drive to the hard 
drive frame.

i. Remove the hard drive from the hard drive frame 4.

j. Remove the hard drive connector 5 from the hard drive.

Removing the Hard Drive Frame and Connector

Reverse the above procedure to reassemble and install the 
hard drive.
Maintenance and Service Guide 5–9



Removal and Replacement Procedures
5.4 Notebook Feet
The notebook feet are adhesive-backed rubber pads. The 
notebook feet are included in the Miscellaneous Plastics Kit, 
spare part number 353393-001. 

» Attach the notebook feet to the base enclosure as illustrated 
below.

Replacing the Notebook Feet
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Removal and Replacement Procedures
5.5 Mini PCI Communications Board

1. Prepare the notebook for disassembly (Section 5.3).

2. Turn the notebook upside down, with the rear toward you.

3. Loosen the PM2.5×3.5 screw 1 that secures the Mini PCI 
compartment cover to the notebook.

4. Lift the left side of the cover 2 up and swing it to the right.

5. Remove the cover.

✎ The Mini PCI compartment cover is included in the 
Miscellaneous Plastics Kit, spare part number 353393-001.

Removing the Mini PCI Compartment Cover

Spare Part Number Information

Mini PCI communications cards

802.11a/b/g LAN card
802.11b/g LAN card

325525-001
325526-001

Wireless LAN cards

802.11b (MOW)
802.11b (ROW)

345641-001
345640-001
Maintenance and Service Guide 5–11



Removal and Replacement Procedures
6. Disconnect the 2 antenna cables 1 from the Mini PCI 
communications board. Note that the longer cable connects 
to the rear antenna terminal and the shorter antenna cable 
connects to the front antenna terminal.

7. Spread the retaining tabs 2 that secure the Mini PCI 
communications board to the socket. The board rises up.

8. Pull the board 3 away from the socket at a 45-degree angle.

Disconnecting the Cables and Removing the Mini PCI 
Communications Board

Reverse the above procedure to install a Mini PCI 
communications board.

Å
WARNING: To prevent an unresponsive system and the display of a 
warning message, install only a Mini PCI device authorized for use in 
your notebook by the governmental agency that regulates wireless 
devices in your country. If you install a device and then receive a 
warning message, remove the device to restore notebook funtionality. 
Then contact Customer Care.
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Removal and Replacement Procedures
5.6 MultiBay Device

1. Prepare the notebook for disassembly (Section 5.3).

2. Turn the notebook upside down, with the left side 
toward you.

3. Slide and hold the MultiBay release latch to the right 1.

4. Pull on the notch 2 in the MultiBay device bezel and remove 
the device 3 from the notebook.

Removing a MultiBay Device

Reverse the above procedure to install a MultiBay device.

Spare Part Number Information

MultiBay devices

24X CD-ROM Drive
8X/24X DVD-ROM Drive
24X DVD+RW/R and CD-RW Combo Drive
24X DVD/CD-RW Combo Drive
Diskette drive
8-cell, prismatic, 3.6-Ah, 52-Wh battery pack

228746-001
251292-001
344256-001
346789-001
241955-001
267747-001
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Removal and Replacement Procedures
5.7 Bluetooth Wireless 
Communications Board

1. Prepare the notebook for disassembly (Section 5.3).

2. Turn the notebook upside down, with the right side 
toward you.

3. Loosen the PM2.0×5.0 screw 1 that secures the Bluetooth 
cover to the notebook.

4. Remove the cover 2 from the notebook as far as the cable 
will allow.

5. Disconnect the cable 3 from the Bluetooth board.

Removing the Bluetooth Cover

Spare Part Number Information

Bluetooth wireless communications board
With cable
Without cable

348277-001
348276-001
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Removal and Replacement Procedures
6. Remove the two PM1.5×3.0 screws 1 that secure the 
Bluetooth board to the Bluetooth cover.

7. Remove the board 2 from the cover.

✎ The Bluetooth cover is included in the Miscellaneous Plastics 
Kit, spare part number 353393-001.

Removing the Bluetooth Board

Reverse the above procedure to install a Bluetooth board.
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Removal and Replacement Procedures
5.8 Keyboard

1. Prepare the notebook for disassembly (Section 5.3).

2. Turn the notebook upside down, with the front toward you.

Spare Part Number Information

Keyboards (include pointing stick)

Brazil
Czech Republic
Denmark
European 
France
French Canada
Germany
Hungary
Iceland
India
International
Israel
Italy
Japan
Korea

344390-201
344390-221
344390-081
344390-A41
344390-051
344390-121
344390-041
344390-211
344390-DD1
344390-D61
344390-B31
344390-BB1
344390-061
344390-291
344390-AD1

Latin America
Norway
Portugal
Russia
Saudi Arabia
Slovenia
Spain
Sweden/Finland
Switzerland
Taiwan
Thailand
Turkey
United Kingdom
United States

344390-161
344390-091
344390-131
344390-251
344390-171
344390-BA1
344390-071
344390-101
344390-111
344390-AB1
344390-281
344390-141
344390-031
344390-001
5–16 Maintenance and Service Guide



Removal and Replacement Procedures
3. Remove the two T8M2.5×9.0 screws that secure the keyboard 
to the notebook.

Removing the Keyboard Screws

4. Turn the notebook right-side up, with the front toward you.

5. Open the notebook.
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Removal and Replacement Procedures
6. Slide the 4 tabs on the top edge of the keyboard toward you.

Releasing the Keyboard Latches

7. Lift the rear edge of the keyboard up and swing it toward you 
until it rests on the palm rest.

Releasing the Keyboard
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Removal and Replacement Procedures
8. Release the ZIF connector 1 to which the keyboard cable 
is attached and disconnect the cable 2.

Disconnecting the Keyboard Cable

Reverse the above procedure to install the keyboard.
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Removal and Replacement Procedures
5.9 Switch Cover

1. Prepare the notebook for disassembly (Section 5.3).

2. Remove the keyboard (Section 5.8).

3. Close the notebook.

4. Turn the notebook upside down, with the rear panel 
toward you.

5. Remove the two T8M2.5×9.0 screws that secure the switch 
cover to the notebook.

Removing the Switch Cover Screws

6. Turn the notebook right-side up, with the front toward you.

Spare Part Number Information

LED switch cover
for use with HP Compaq Business Notebook nx5000
for use with Compaq Presario V1000 notebook PC

353389-001
359920-001
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Removal and Replacement Procedures
7. Open the notebook.

8. Using a flat-bladed tool, lift up the left 1 and right 2 ends 
of the switch cover to disengage it from the notebook.

9. Remove the switch cover 3.

Removing the Switch Cover

Reverse the above procedure to install the switch cover.
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Removal and Replacement Procedures
5.10 Modem Board

1. Prepare the notebook for disassembly (Section 5.3).

2. Release the keyboard (Section 5.8).

3. Remove the switch cover (Section 5.9).

4. Remove the two PM2.0×3.0 screws 1 that secure the modem 
board to the notebook.

5. Lift the rear edge of the modem board 2 to disconnect it 
from the system board.

Spare Part Number Information

Modem board (includes cable) 325521-001
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Removal and Replacement Procedures
6. Turn the modem board 1 over and disconnect the modem 
cable 2 from the modem board.

7. Remove the modem board.

Removing the Modem Board

Reverse the above procedure to install the modem board.
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Removal and Replacement Procedures
5.11 Memory Module

1. Prepare the notebook for disassembly (Section 5.3).

2. Remove the keyboard (Section 5.8).

3. Press in on the latch to release the memory shield and lift 
the left side of the memory shield 1 until it rests at a 
45-degree angle.

4. Slide the shield to the left 2 to remove it.

✎ The memory shield is included in the Miscellaneous Plastics 
Kit, spare part number 353393-001.

Removing the Memory Shield

Spare Part Number Information

Memory modules, 266-MHz

1024-MB DDR
512-MB DDR
256-MB DDR
128-MB DDR

336579-001
336578-001
336577-001
336576-001
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Removal and Replacement Procedures
5. Spread the retaining tabs 1 that secure the memory module 
to the socket. The module rises up.

6. Pull the module 2 away from the socket at a 45-degree angle.

Removing a Memory Module

Reverse the above procedure to install a memory module.
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Removal and Replacement Procedures
5.12 Keyboard Plate

✎ The keyboard plate is included in the Miscellaneous Plastics 
Kit, spare part number 353393-001.

1. Prepare the notebook for disassembly (Section 5.3).

2. Remove the keyboard (Section 5.8).

3. Remove the switch cover (Section 5.9).

4. Remove the memory shield (Section 5.11).

5. Slide the keyboard plate toward the back of the notebook 1 
to disengage the plate tabs from the slots 2 in the top cover, 
and then lift the plate straight up 3 to remove it.

Removing the Keyboard Plate

Reverse the above procedure to install the keyboard plate.
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Removal and Replacement Procedures
5.13 Fan Assembly

1. Prepare the notebook for disassembly (Section 5.3).

2. Remove the keyboard (Section 5.8).

3. Remove the switch cover (Section 5.9).

4. Remove the memory shield (Section 5.11).

5. Remove the keyboard plate (Section 5.12).

6. Turn the notebook upside down with the rear side toward 
you and remove the T8M2.5x5.0 screw that secures the 
fan assembly to the notebook.

Spare Part Number Information

Fan assembly 345065-001
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Removal and Replacement Procedures
7. Turn the notebook right-side up and open it.

8. Disconnect the fan cable 1 from the system board.

9. Remove the PM2.5×7.0 screw 2 that secures the fan 
assembly to the notebook.

Removing the Fan Assembly Screws
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Removal and Replacement Procedures
10. Lift the left side of the fan assembly 1 until it rests at an 
angle.

11. Slide the fan assembly up and to the left 2 to remove it from 
the notebook.

Removing the Fan Assembly

Reverse the above procedure to install the fan assembly.
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Removal and Replacement Procedures
5.14 Heat Sink

1. Prepare the notebook for disassembly (Section 5.3) and 
remove the following components:

❏ Keyboard (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Memory shield (Section 5.12)

❏ Keyboard plate (Section 5.11)

❏ Fan assembly (Section 5.13)

2. Remove the four T8M2.5×5.0 screws that secure the heat 
sink bracket to the system board in the order indicated on 
top of the heat sink bracket.

Removing the Heat Sink Bracket Screws

Spare Part Number Information

Heat sink 344410-001
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Removal and Replacement Procedures
3. Lift the left side of the heat sink 1 up until the thermal grease 
bond between the heat sink and the processor disengages.

4. Slide the cooling fins 2 forward until they clear the top cover.

5. Lift the heat sink straight up to remove it.

Removing the Heat Sink
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Removal and Replacement Procedures
✎ Carefully clean any thermal grease residue from the underside 
of the heat sink 1 and processor surfaces 2 each time you 
remove the heat sink. Then apply new thermal grease to both 
surfaces.

Removing the Thermal Grease from the Heat Sink and Processor

Reverse the above procedure to install the heat sink.
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Removal and Replacement Procedures
5.15 Processor

1. Prepare the notebook for disassembly (Section 5.3) and 
remove the following components:

❏ Keyboard (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Memory shield (Section 5.11)

❏ Keyboard plate (Section 5.12)

❏ Fan assembly (Section 5.13)

❏ Heat sink (Section 5.14)

Spare Part Number Information

Processors (include thermal grease)

Intel Celeron M processor, 1.4-GHz
Intel Celeron M processor, 1.3-GHz
Intel Celeron M processor, 1.2-GHz
Intel Pentium M processor (2-MB L2 cache), 2.0-GHz
Intel Pentium M processor (2-MB L2 cache), 1.8-GHz
Intel Pentium M processor (2-MB L2 cache), 1.7-GHz
Intel Pentium M processor (2-MB L2 cache), 1.6-GHz
Intel Pentium M processor (2-MB L2 cache), 1.5-GHz
Intel Pentium M processor (1-MB L2 cache), 1.7-GHz
Intel Pentium M processor (1-MB L2 cache), 1.6-GHz
Intel Pentium M processor (1-MB L2 cache), 1.5-GHz
Intel Pentium M processor (1-MB L2 cache), 1.4-GHz

359637-001
356599-001
356598-001
353395-001
345857-001
356597-001
356596-001
359636-001
340165-001
319777-001
347253-001
319775-001
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Removal and Replacement Procedures
2. Use a flat-bladed screwdriver to turn the processor lock 
screw 1 one-quarter turn counterclockwise to release the 
processor from the socket.

3. Lift the processor 2 straight up to remove it.

✎ Note that the gold triangle 3 on the processor should be 
aligned in the lower right corner when you install the 
processor.

Removing the Processor

Reverse the above procedure to install the processor.
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Removal and Replacement Procedures
5.16 Display Assembly

1. Prepare the notebook for disassembly (Section 5.3).

2. Disconnect the wireless antenna cables from the Mini PCI 
communications board (Section 5.5).

3. Remove the following components:

❏ Mini PCI board (Section 5.5)

❏ Keyboard (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Memory shield (Section 5.11)

❏ Keyboard plate (Section 5.12)

Spare Part Number Information

Display assemblies

for use with HP Compaq Business Notebook nx5000
14.1-inch, TFT, XGA
15.0-inch, TFT, XGA
15.0-inch, TFT, SXGA+WVA

for use with Compaq Presario V1000 notebook PC
14.1-inch, TFT, XGA
15.0-inch, TFT, XGA
15.0-inch, TFT, SXGA+WVA

353384-001
353385-001
353386-001

359916-001
359917-001
359918-001
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Removal and Replacement Procedures
4. Disconnect the display cable 1 from the system board.

5. Remove the left and right wireless antenna cables from 
the groove 2 in the top cover.

6. Carefully work the wireless antenna cables 3 up through the 
hole in the system board from the Mini PCI compartment.

Disconnecting the Display Cables
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Removal and Replacement Procedures
7. Close the notebook.

8. Turn the notebook upside down, with the rear panel 
toward you.

9. Remove the following screws:

❏ Two T8M2.5×9.0 screws 1 from the rear panel.

❏ Two T8M2.5×9.0 screws 2 from the bottom of the 
notebook.

Removing the Display Screws
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Removal and Replacement Procedures
10. Turn the notebook right-side up, with the front toward you.

11. Open the notebook until the display assembly is in an 
upright position.

12. Lift the display assembly 1 straight up to remove it.

13. If necessary, remove the left and right display hinge covers 2 
from the display assembly.

✎ The display hinges, hinge covers, hinge screw caps, and 
display bumpers are included in the Miscellaneous Plastics Kit, 
spare part number 353393-001.

Removing the Display Assembly

Reverse the above procedure to install the display assembly.
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Removal and Replacement Procedures
5.17 Top Cover

1. Prepare the notebook for disassembly (Section 5.3) and 
remove the following components:

❏ MultiBay device (Section 5.6)

❏ Keyboard (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Memory shield (Section 5.11)

❏ Keyboard plate (Section 5.12)

❏ Display assembly (Section 5.16)

2. Turn the notebook upside down, with the rear panel 
toward you.

Spare Part Number Information

Top Cover (includes TouchPad)
for use with HP Compaq Business Notebook nx5000
for use with Compaq Presario V1000 notebook PC

353387-001
359919-001
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Removal and Replacement Procedures
3. Remove the following screws:

❏ Ten T8M2.5×9.0 screws 1 along the front edge, sides, 
rear corners and center of the bottom of the notebook.

❏ Three T8M2.5x3.0 screws 2 from the MultiBay.

❏ Two T8M2.5×3.0 screws 3 from the hard drive bay.

❏ Two T8M2.5×5.0 screws 4 from the rear panel.

Removing the Top Cover Screws
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Removal and Replacement Procedures
4. Turn the notebook right-side up, with the front toward you.

5. Release the ZIF connector 1 to which the TouchPad cable 
is attached and disconnect the TouchPad cable 2.

6. Disconnect the RTC battery cable 3 from the system board.

Removing the TouchPad and RTC Battery Cables
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Removal and Replacement Procedures
7. Lift the right side 1 of the top cover until it rests at a 
45-degree angle.

8. Slide the top cover to the left to disengage the audio 
connectors 2 from the top cover.

9. Remove the top cover 3.

Removing the Top Cover

Reverse the above procedure to install the top cover.
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Removal and Replacement Procedures
5.18 RTC Battery

✎ The RTC battery is included in the Miscellaneous Plastics Kit, 
spare part number 353393-001.

1. Prepare the notebook for disassembly (Section 5.3) and 
remove the following components:

❏ Keyboard (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Memory shield (Section 5.11)

❏ Keyboard plate (Section 5.12)

❏ Display assembly (Section 5.16)

❏ Top cover (Section 5.17)

2. Turn the top cover upside down, with the front toward you.
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Removal and Replacement Procedures
3. Lift the RTC battery out of the top cover clip.

Removing the RTC Battery

Reverse the above procedure to install the RTC battery.
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Removal and Replacement Procedures
5.19 Speakers

✎ The speakers are included in the Miscellaneous Plastics Kit, 
spare part number 353393-001 and with the base 
enclosure, spare part number 353388-001.

1. Prepare the notebook for disassembly (Section 5.3) and 
remove the following components:

❏ Keyboard (Section 5.8)

❏ Memory shield (Section 5.10)

❏ Switch cover (Section 5.11)

❏ Keyboard plate (Section 5.12)

❏ Fan assembly (Section 5.13)

❏ Heat sink (Section 5.14)

❏ Display assembly (Section 5.16)

❏ Top cover (Section 5.17)

2. Turn the notebook right-side up, with the front toward you.
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Removal and Replacement Procedures
3. Release the ZIF connector 1 on the system board to which 
the LED board cable is attached and disconnect the cable 2.

4. Lift up the tape 3 that holds the LED board connector cable 
to the speaker.

5. Disconnect the speaker cable 4 from the connector on the 
system board.

Releasing the LED board and Speaker Cables
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Removal and Replacement Procedures
6. Remove the PM1.5x4.0 screw 1 that secures the speaker 
assembly to the base enclosure.

7. Lift the speaker assembly 2 from the base enclosure.

Removing the Speaker Assembly
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Removal and Replacement Procedures
5.20LED Board

1. Prepare the notebook for disassembly (Section 5.3) and 
remove the following components:

❏ Keyboard (Section 5.8)

❏ Memory shield (Section 5.10)

❏ Switch cover (Section 5.11)

❏ Keyboard plate (Section 5.12)

❏ Display assembly (Section 5.16)

❏ Top cover (Section 5.17)

❏ Speaker assembly (Section 5.19)

2. Turn the notebook right-side up, with the front toward you.

Spare Part Number Information

LED board (includes cable) 353391-001
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Removal and Replacement Procedures
3. Release the ZIF connector 1 on the system board to which 
the LED board cable is attached, and then disconnect the 
cable 2.

4. Remove the PM1.5x4.0 screw 3 that secures the LED board 
to the base enclosure.

5. Lift the board straight up to remove it 4.

6. Release the ZIF connector 5 on the LED board to which the 
LED board cable is attached and disconnect the cable 6.

Removing the LED Board 

Reverse the above procedure to install the LED board.
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Removal and Replacement Procedures
5.21Bottom Board

1. Prepare the notebook for disassembly (Section 5.3) and 
remove the following components:

❏ Keyboard (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Modem board (Section 5.10)

❏ Memory shield (Section 5.11)

❏ Keyboard plate (Section 5.12)

❏ Display assembly (Section 5.16)

❏ Top cover (Section 5.17)

2. Turn the notebook right-side up, with the front toward you.

Spare Part Number Information

Bottom board 353392-001
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Removal and Replacement Procedures
3. Remove the two PM2.5×5.0 screws 1 that secure the bottom 
board to the notebook.

4. Lift the front and rear edges of the bottom board to 
disconnect it from the system board 2.

5. Remove the bottom board.

Removing the Bottom Board

Reverse the above procedure to install the bottom board.
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Removal and Replacement Procedures
5.22System Board

✎ When replacing the system board, ensure that the following 
components are removed or disconnected from the defective 
system board and installed on or reconnected to the replacement 
system board:
■ Mini PCI communications board (Section 5.5)
■ Bluetooth wireless communications board cable  

(Section 5.7)
■ Memory modules (Section 5.11)
■ Processor (Section 5.15)
■ Speaker assembly cable (Section 5.19)

1. Prepare the notebook for disassembly (Section 5.3) and 
remove the following components:

❏ Mini PCI communications board (Section 5.5)

❏ MultiBay device (Section WARNING:)

❏ Bluetooth wireless communications board (Section 5.7)

❏ Keyboard (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Modem board (Section 5.10)

❏ Memory shield (Section 5.11)

❏ Keyboard plate (Section 5.12)

❏ Fan assembly (Section 5.13)

❏ Heat sink (Section 5.14)

❏ Processor (Section 5.15)

Spare Part Number Information

System board 353390-001
5–52 Maintenance and Service Guide



Removal and Replacement Procedures
❏ Display assembly (Section 5.16)

❏ Top cover (Section 5.17)

❏ Speaker assembly cable (Section 5.19)

❏ LED board (Section 5.20)

❏ Bottom board (Section 5.21)

❏ Any Secure Digital (SD) cards in the SD Card slots

2. Remove the six PM2.5×5.0 screws 1 that secure the system 
board to the notebook.

3. Remove the PM2.5x11.5 screw 2 that secures the hard drive 
connector to the system board.

4. Use a 5.0-mm socket to remove the two HM5.0×9.0 
standoffs 3 that secure the system board to the notebook.

Removing the System Board Screws and Standoffs
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Removal and Replacement Procedures
5. Lift the front edge of the system board 1 until it rests at 
an angle.

6. Slide the system board toward you at an angle 2, and then 
lift it straight up to remove it.

Removing the System Board

Reverse the above procedure to install the system board.
5–54 Maintenance and Service Guide



6
Specifications

This chapter provides physical and performance specifications.

Table 6-1
Notebook 

Dimensions

Height
Width
Depth

3.67 cm
32.60 cm
27.50 cm

1.44 in
12.83 in
10.83 in

Weight

With 14.1-inch display
With 6-cell battery 
pack and MultiBay 
weight saver

With 6-cell battery 
pack and MultiBay 
DVD-ROM drive

With 8-cell battery 
pack and MultiBay 
DVD-ROM drive

2.47 kg 
 

2.72 kg

2.81 kg

5.44 lb 
 

6.00 lb

6.19 lb

With 15.0-inch display
With 6-cell battery 
pack and MultiBay 
weight saver

With 6-cell battery 
pack and MultiBay 
DVD-ROM drive

With 8-cell battery 
pack and MultiBay 
DVD-ROM drive

2.61 kg 
 

2.82 kg

2.91 kg

5.75 lb 
 

6.21 lb

6.41 lb
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Specifications
Stand-alone power requirements

Nominal operating 
voltage

Peak operating power

14.4 V dc (8-cell battery)
10.8 V dc (6-cell battery)
65 W

Temperature

Operating (not writing 
optical)

Operating (writing 
optical)

Nonoperating

0°C to 35°C 

5°C to 35°C 

-20°C to 60°C

32°F to 95°F 

41°F to 95°F 

-4°F to 140°F

Relative humidity (noncondensing)

Operating
Nonoperating

10% to 90%
5% to 95%, 38.7°C (101.6°F)  
maximum wet bulb temperature

Altitude (unpressurized)

Operating (14.7 psia to 
10.1 psia)

Nonoperating (14.7 
psia to 4.4 psia)

-15 m to 3,048 m 

-15 m to 12,192 m

-50 ft to 10,000 ft 

-50 ft to 40,000 ft

Shock

Operating
Nonoperating

50 g, 2 ms, half-sine
175 g, 2 ms, half-sine

Random vibrations

Operating
Non-operating

0.75 g
1.50 g

✎ Applicable product safety standards specify thermal limits for 
plastic surfaces. The notebook operates well within this range of 
temperatures.

Table 6-1
Notebook (Continued)
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Specifications
Table 6-2
14.1-inch XGA TFT Display

Dimensions

Height
Width
Diagonal

28.6 cm
21.4 cm
35.7 cm

11.2 in
  8.4 in
14.1 in

Number of colors 16M

Contrast ratio 250:1 typical

Refresh rate 60 Hz

Brightness 150 nits typical (min)

Pixel resolution

Pitch
Format
Configuration

0.279 × 0.279 mm
1024 × 768
RGB stripe

Backlight CCFT

Character display 80 × 25

Total power 
consumption

4.0 W

Viewing angle ±45° horizontal, +15/-35° vertical (typical)
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Specifications
Table 6-3
15.0-inch XGA TFT Display

Dimensions

Height
Width
Diagonal

30.4 cm
22.8 cm
35.7 cm

11.8 in
  9.0 in
15.0 in

Number of colors 16M

Contrast ratio 250:1 typical

Refresh rate 60 Hz

Brightness 150 nits typical (min)

Pixel resolution

Pitch
Format
Configuration

0.279 × 0.279 min
1024 × 768
RGB stripe

Backlight CCFT

Character display 80 × 25

Total power 
consumption

5.5 W

Viewing angle ±40° horizontal, +20/-40° vertical (typical)
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Specifications
Table 6-4
15.0-inch SXGA+WVA TFT Display

Dimensions

Height
Width
Diagonal

30.4 cm
22.8 cm
35.7 cm

11.8 in
  9.0 in
15.0 in

Number of colors 16M

Contrast ratio 250:1 typical

Refresh rate 60 Hz

Brightness 150 nits typical (min)

Pixel resolution

Pitch
Format
Configuration

0.204 × 0.204 mm
1400 × 1050
RGB stripe

Backlight CCFT

Character display 80 × 25

Total power 
consumption

6.0 W

Viewing angle ±60° horizontal, +40/-60° vertical (typical)
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Specifications
 

Table 6-5
Hard Drives 

60-GB 60-GB 40-GB 40-GB 30-GB

User 
capacity per 
drive1

60 GB 60 GB 40 GB 40 GB 30 GB

Dimensions

Height
Width
Weight

9.5 mm
70 mm
102 g

9.5 mm
70 mm
102 g

9.5 mm
70 mm
102 g

9.5 mm
70 mm
102 g

9.5 mm
70 mm
102 g

Interface 
type

ATA-5 ATA-5 ATA-5 ATA-5 ATA-5

Transfer rate

Synchronous 
(maximum)

Security

100 MB/ 
sec

ATA 
security

100 MB/ 
sec

ATA 
security

100 
MB/sec

ATA 
security

100 MB/ 
sec

ATA 
security

100 MB/ 
sec

ATA 
security

Seek times (typical read, including setting)

Single 
track

Average
Maximum

3.0 ms

13 ms
24 ms

3.0 ms

13 ms
24 ms

3.0 ms

13 ms
24 ms

3.0 ms

13 ms
24 ms

2.5 ms

12 ms
23 ms

Logical 
blocks2

117,210,240 117,210,240 78,140,160 78,140,160 58,605,120

Disk 
rotational 
speed

5400 rpm 4200 rpm 5400 rpm 4200 rpm 4200 rpm

Operating 
temperature

5°C to 55°C (41°F to 131°F)

11 GB = 1,073,741,824 bytes.
2Actual drive specifications may differ slightly.

Certain restrictions and exclusions apply. Consult Customer Care for details.
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Specifications
Table 6-6
External AC Adapter

Weight

Adapter
Power cord

0.29 kg
0.13 kg

0.65 lb
0.29 lb

Power supply

Operating voltage
Operating current
Operating frequency range
Maximum transient

90 to 264 VAC RMS
1.6 A RMS
47 to 63 Hz AC
4/50 kV

Table 6-7
Primary 6-Cell, Li-Ion Battery Pack

Dimensions

Height
Width
Depth
Weight

1.90 cm
7.60 cm
14.70 cm
0.34 kg

0.75 in
3.00 in
5.80 in
0.75 lb

Energy

Voltage
Amp-hour capacity
Watt-hour capacity

11.1 V
4.4 Ah
48 Wh

Temperature

Operating
Nonoperating

5°C to 45°C
0°C to 60°C

41°F to 113°F
32°F to 140°F
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Specifications
Table 6-8
Optional High-Capacity 8-Cell, Li-Ion Battery Pack

Dimensions

Height
Width
Depth
Weight

1.90 cm
7.60 cm
14.70 cm
0.43 kg

0.75 in
3.00 in
5.80 in
0.94 lb

Energy

Voltage
Amp-hour capacity
Watt-hour capacity

14.4 V
4.4 Ah
63 Wh

Temperature

Operating
Nonoperating

5°C to 45°C
0°C to 60°C

41°F to 113°F
32°F to 140°F

Table 6-9
Optional MultiBay 8-Cell, Li-Ion Battery Pack

Dimensions

Height
Width
Depth
Weight

1.30 cm
13.20 cm
13.90 cm
0.39 kg

0.50 in
5.20 in
5.45 in
0.86 lb

Energy

Voltage
Amp-hour capacity
Watt-hour capacity

14.8 V
3.6 Ah
53 Wh

Temperature

Operating
Nonoperating

5°C to 45°C
0°C to 60°C

41°F to 113°F
32°F to 140°F
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Specifications
Table 6-10
24X Max DVD+RW/R and CD-RW Combo Drive 

Applicable disc Read:

DVD-R
DVD-RW
DVD-ROM (DVD-5, 
DVD-9, DVD-10, 
DVD-18) 
CD-ROM (Mode 1 
and 2) 
CD Digital Audio 
CD-XA ready (Mode 
2, Form 1 and 2) 
CD-I ready (Mode 
2, Form 1 and 2) 
CD-R 
CR-RW 
Photo CD (sin-
gle/multisession) 
CD-Bridge

Write:

CD-R
CD-RW
DVD-R

DVD-RW

Center hole diameter 1.5 cm 0.59 in

Disc diameter

Standard disc
Mini disc

12 cm
8 cm

4.72 in
3.15 in

Disc thickness 1.2 mm 0.047 in

Track pitch 0.74 µm

Access time CD DVD

Random

Full stroke

<175 ms
<285 ms

<230 ms

<335 ms

Audio output level Line-out, 0.7 V rms

Cache buffer 2 MB
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Specifications
Data transfer rate

CD-R (16X)
CD-RW (8X)
CD-ROM (24X)
DVD (8X)
DVD-R (4X) 
DVD-RW (2X) 
Multiword DMA mode 2

2,400 KB/s (150 KB/s at 1X CD rate)
1,200 KB/s (150 KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1,352 KB/s at 1X DVD rate)
5,400 KB/s (1,352 KB/s at 1X DVD rate)
2,700 KB/s (1,352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 6-10
24X Max DVD+RW/R and CD-RW Combo Drive (Continued)
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Specifications
Table 6-11
24X Max DVD/CD-RW Combo Drive 

Applicable disc Read:

DVD-R
DVD-RW
DVD-ROM (DVD-5, 
DVD-9, DVD-10, 
DVD-18) 
CD-ROM (Mode 1 
and 2) 
CD Digital Audio 
CD-XA ready (Mode 
2, Form 1 and 2) 
CD-I ready (Mode 
2, Form 1 and 2) 
CD-R 
CR-RW 
Photo CD (sin-
gle/multisession) 
CD-Bridge

Write:

CD-R
CD-RW

Center hole diameter 1.5 cm 0.59 in

Disc diameter

Standard disc
Mini disc

12 cm
8 cm

4.72 in
3.15 in

Disc thickness 1.2 mm 0.047 in

Track pitch 0.74 µm

Access time CD DVD

Random

Full stroke

< 110 ms
< 210 ms

<130 ms

<225 ms

Audio output level Line-out, 0.7 V rms

Cache buffer 2 MB
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Specifications
Data transfer rate

CD-R (24X)
CD-RW (10X)
CD-ROM (24X)
DVD (8X)
Multiword DMA mode 2

3,600 KB/s (150 KB/s at 1X CD rate)
1,500 KB/s (150 KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 6-11
24X Max DVD/CD-RW Combo Drive (Continued)
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Specifications
Table 6-12
8X/24X DVD-ROM Drive 

Applicable disc Read:

DVD-ROM (DVD-5, DVD-9, DVD-10, 
DVD-18) 
CD-ROM (Mode 1 and 2) 
CD Digital Audio 
CD-XA ready (Mode 2, Form 1 and 2) 
CD-I ready (Mode 2, Form 1 and 2) 
CD-R 
CD-RW 
Photo CD (single/multisession) 
CD-Bridge

Center hole diameter 1.5 cm 0.59 in

Disc diameter

Standard disc
Mini disc

12 cm
8 cm

4.72 in
3.15 in

Disc thickness 1.2 mm 0.047 in

Track pitch 0.74 µm

Access time

Random DVD media
Full stroke DVD media

Random CD media
Full stroke CD media

< 125 ms
< 225 ms
< 100 ms
< 175 ms

Audio output level Line-out, 0.7 V rms

Cache buffer 512 KB
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Specifications
Data transfer rate

CD-R (24X) 
CD-RW (10X) 
CD-ROM (24X)
DVD (8X)
Multiword DMA mode 2

 3,600 KB/s (150KB/s at 1X CD rate)
1,500 KB/s (150KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds

Table 6-12
8X/24X DVD-ROM Drive (Continued)
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Specifications
Table 6-13
24X CD-ROM Drive 

Applicable disc CD-ROM (Mode 1 and 2) 
CD Digital Audio 
CD-XA ready (Mode 2, Form 1 and 2) 
CD-I ready (Mode 2, Form 1 and 2) 
CD-R 
CD-RW 
Photo CD (single/multisession) 
CD-Bridge

Center hole diameter 1.5 cm 0.59 in

Disc diameter

Standard disc

Mini disc

12 cm
8 cm

4.72 in

3.15 in

Disc thickness 1.2 mm 0.047 in

Track pitch 1.6 µm

Access time

Random

Full stroke

< 110 ms
< 220 ms

Audio output level Line-out, 0.7 V rms

Cache buffer 128 KB/s

Data transfer rate

CD-ROM (24X)
Multiword DMA mode 2

3,600 KB/s (150 KB/s at 1X CD rate)
16.6 MB/s

Startup time < 8 seconds

Stop time < 4 seconds
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Specifications
Table 6-14
System DMA

Hardware 
DMA

System 
Function

DMA1 Available for parallel

DMA2 Floppy Disk Controller

DMA3 Fast Infrared port

DMA4 DMA controller cascading (not available)
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Specifications
Table 6-15
System Interrupts

Hardware 
IRQ

System 
Function

IRQ0 System timer

IRQ1 Keyboard controller

IRQ2 Cascaded

IRQ3 Infrared

IRQ4 COM1

IRQ5 Available for Parallel port

IRQ6 Diskette drive

IRQ7 Available for Parallel port

IRQ8 Real time clock (RTC)

IRQ9 Microsoft ACPI-Compliant System

IRQ12 Internal point stick or external mouse

IRQ13 Numeric Data Processor

IRQ14 Primary IDE Channel

IRQ15 Secondary IDE Channel

IRQ 16 Graphics Controller and USB Host Controller

IRQ 17 Audio and Modem

IRQ 18 USB Host Controller, Cardbus Controller, and FlashMedia 
Controller

IRQ 19 USB Host Controller

IRQ 20 LAN Controller

IRQ 21 Mini PCI Wireless Adapter

IRQ 23 USB 2.0 Host Controller and 1394 Host Controller

✎ Either the infrared or the serial port may assert IRQ3 or IRQ4.
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Specifications
Table 6-16
System I/O Addresses 

I/O Address 
(hex)

System Function 
(shipping configuration)

000 - CF7 DMA controller; PCI bus

010 - 01F Motherboard resources

020 - 021 Programmable Interrupt Controller

024 - 03F Motherboard resources

040 - 043 System Timer

04E - 04F Motherboard resources

050 - 053 Motherboard resources

060 Keyboard Controller

061 System speaker

062 - 063 Microsoft ACPI-Compliant Controller

064 Keyboard Controller

066 Microsoft ACPI-Compliant Controller

068 - 06F Motherboard resources

070 - 071 System CMOS/real time clock

072 - 073 System CMOS/real time clock

074 - 077 Motherboard resources

080 - 08F DMA Controller

090 - 09F Motherboard resources

0A0 - 0A1 Programmable Interrupt Controller
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Specifications
I/O Address 
(hex)

System Function 
(shipping configuration)

0A4 - 0BD Motherboard resources

0C0 - 0DF DMA Controller

0F0 - 0FF Numeric Data Processor

100 - 107 Fast Infrared Port

140 - 14F Motherboard resources

170 - 177 Secondary IDE Channel

1F0 - 1F7 Primary IDE Channel

274 - 277 ISAPNP Read Data Port

279 ISAPNP Read Data Port

376 Secondary IDE Channel

378 - 37F Parallel port (LPT1)

3B0 - 3BB Graphics Controller

3C0 - 3DF Graphics Controller

3E8 - 3EF Fast Infrared Port

3F0 - 3F5 Floppy Disk Controller

3F6 Primary IDE Channel

3F7 Floppy Disk Controller

3F8 - 3FF Serial port (COM1)

4D0 - 4D1 Motherboard resources

Table 6-16
System I/O Addresses (Continued)
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Specifications
I/O Address 
(hex)

System Function 
(shipping configuration)

778 - 77A Parallel Port (LPT1)

A79 ISAPNP Read Data Port

D00 - FFFF PCI bus

1000 - 107F Motherboard resources

1100 - 113F Motherboard resources

1200 - 121F Motherboard resources

2000 - 20FF Digital Audio

2400 - 24FF Modem

2800 - 287F Modem

2880 - 28BF Digital Audio

28C0 - 28DF USB Universal Host Controller

28E0 - 28FF USB Universal Host Controller

2C00 - 2C1F USB Universal Host Controller

28C0 - 28DF USB Universal Host Controller

2C20 - 2C2F Ultra ATA Storage Controller

2C30 - 2C37 Graphics Controller

FC00 - FCFF Cardbus Controller

FD00 - FDFF Cardbus Controller

FE00 - FEFF Cardbus Controller

FF00 - FFFF Cardbus Controller

Table 6-16
System I/O Addresses (Continued)
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A
Connector Pin Assignments

Table A-1
RJ-45 Network Interface

Pin Signal Pin Signal

1 Transmit + 5 Unused

2 Transmit – 6 Receive –

3 Receive + 7 Unused

4 Unused 8 Unused
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Connector Pin Assignments
Table A-2
RJ-11 Modem

Pin Signal Pin Signal

1 Unused 4 Unused

2 Tip 5 Unused

3 Ring 6 Unused

Table A-3
Universal Serial Bus

Pin Signal Pin Signal

1 +5 VDC 3 Data +

2 Data – 4 Ground
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Connector Pin Assignments
Table A-4
S-Video

Pin Signal Pin Signal

1 Ground (Y) 3 Y-Luminance (Intensity)

2 Ground (C) 4 C-Chrominance (Color)

Table A-5
External Monitor

Pin Signal Pin Signal

1 Red analog 9 +5 VDC

2 Green analog 10 Ground

3 Blue analog 11 Monitor detect

4 Not connected 12 DDC 2B data

5 Ground 13 Horizontal sync

6 Ground analog 14 Vertical sync

7 Ground analog 15 DDC 2B clock

8 Ground analog
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Connector Pin Assignments
Table A-6
Headphone Jack

Pin Signal Pin Signal

1 Ground 2 Left audio signal

3 Right audio signal

Table A-7
Microphone

Pin Signal Pin Signal

1 Audio in 2 Ground
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Connector Pin Assignments
Table A-8
Parallel

Pin Signal Pin Signal

1 Strobe 14 Auto linefeed

2 Data bit 0 15 Error

3 Data bit 1 16 Initialize paper

4 Data bit 2 17 Select in

5 Data bit 3 18 Ground

6 Data bit 4 19 Ground

7 Data bit 5 20 Ground

8 Data bit 6 21 +5VS

9 Data bit 7 22 PTF

10 Acknowledge 23 EXTFDD_VCC (+5V)

11 Busy 24 Ground

12 Paper end 25 Ground

13 Select
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Connector Pin Assignments
Table A-9
Serial

Pin Signal Pin Signal

1 Carrier detect 6 Data set ready

2 Receive data 7 Ready to send

3 Transmit data 8 Clear to send

4 Data terminal ready 9 Ring indicator

5 Ground

Table A-10
1394

Pin Signal Pin Signal

1 Connector housing 5 TPA-

2 Ground 6 TPB-

3 TPB+ 7 Power

4 TPA+
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Maintenance and Service Guide B–1

B
Power Cord Set Requirements

3-Conductor Power Cord Set
The wide range input feature of the notebook permits it to operate 
from any line voltage from 100 to 120 or 220 to 240 volts AC.

The power cord included with the notebook meets the 
requirements for use in the country where the equipment 
is purchased.

Power cords for use in other countries must meet the 
requirements of the country where the notebook is used. For 
more information on power cord requirements, contact an HP 
authorized reseller or service provider.

General Requirements
The requirements listed below are applicable to all countries:

■ The length of the power cord must be at least 1.5 meters 
(5.00 feet) and a maximum of 2.0 meters (6.50 feet).

■ All power cords must be approved by an acceptable 
accredited agency responsible for evaluation in the country 
where the power cord will be used.

■ The appliance coupler must meet the mechanical 
configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of 
the notebook.



C
Screw Listing

This appendix provides specification and reference information 
for the screws used in the notebook. All screws listed in this 
appendix are available in the Miscellaneous Screw Kit, spare part 
number 353394-001.
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Screw Listing
Torx T5M3.0x4.0 Hard Drive Frame Locations

Table C-1
Torx T5M3.0×4.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 4.0 mm 3.0 mm 5.0 mm

Where used:
Two screws that secure the hard drive frame to the hard drive 
(documented in Section 5.3)

mm
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Screw Listing
Phillips PM3.0x3.5 Hard Drive Frame Screw Locations

Table C-2
Phillips PM3.0×3.5 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 3.5 mm 3.0 mm 5.0 mm

Where used:
Two screws that secure the hard drive frame to the hard drive 
(documented in Section 5.3)

mm
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Screw Listing
Hex M2.0×10.0 Hard Drive Alignment Pin Locations

Table C-3
Hex M2.0×10.0 Alignment Pin

Color Qty. Length Thread
Head 
Width

Silver 2 10.0 mm 2.0 mm 4.0 mm

Where used:
Two alignment pins that secure the hard drive frame and connector to the hard 
drive (documented in Section 5.3)

mm
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Screw Listing
Phillips PM2.5×3.0 Screw Location

Table C-4
Phillips PM2.5×3.0 Screw

Color Qty. Length Thread
Head 
Width

Black 1 3.0 mm 2.5 mm 4.0 mm

Where used:
One screw that secures the hard drive to the notebook 
(documented in Section 5.3)

mm
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Screw Listing
Torx T8M2.5×5.0 Fan Assembly Screw Location

Table C-5
Torx T8M2.5×5.0 Screw

Color Qty. Length Thread
Head 
Width

Black 7 5.0 mm 2.5 mm 4.0 mm

Where used:
One screw that secures the fan assembly to the notebook 
(documented in Section 5.13)

mm
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Screw Listing
Torx T8M2.5×5.0 Heat Sink Screw Locations

Table C-5
Torx T8M2.5×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 7 5.0 mm 2.5 mm 4.0 mm

Where used:
Four screws that secure the heat sink to the notebook 
(documented in Section 5.14)

mm
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Screw Listing
Torx T8M2.5×5.0 Top Cover Screw Locations

Table C-5
Torx T8M2.5×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 7 5.0 mm 2.5 mm 4.0 mm

Where used:
Two screws that secure the top cover to the notebook 
(documented in Section 5.17)

mm
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Screw Listing
Phillips PM2.0×4.0 Bottom Board Screw Locations

Table C-6
Phillips PM2.0x4.0 Screws

Color Qty. Length Thread
Head 
Width

Black 9 4.0 mm 2.0 mm 4.0 mm

Where used:
Two screws that secure the bottom board to the notebook 
(documented in Section 5.21)

mm
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Screw Listing
Phillips PM2.0x4.0 System Board Screw Locations

Table C-6
Phillips PM2.0x4.0 Screws (Continued)

Color Qty. Length Thread
Head 
Width

Black 9 4.0 mm 2.0 mm 4.0 mm

Where used:
Six screws that secure the system board to the notebook 
(documented in Section 5.22)

mm
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Screw Listing
Phillips PM2.0x4.0 Hard Drive Cover Screw Location

Table C-6
Phillips PM2.0x4.0 Screws (Continued)

Color Qty. Length Thread
Head 
Width

Black 9 4.0 mm 2.0 mm 4.0 mm

Where used:
One screw that secures the hard drive cover to the notebook 
(documented in Section 5.3)

mm
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Screw Listing
Phillips PM2.0×3.0 Modem Board Screw Locations

Table C-7
Phillips PM2.0×3.0 Screw

Color Qty. Length Thread
Head 
Width

Black 2 3.0 mm 2.0 mm 4.0 mm

Where used:
Two screws that secure the modem board to the notebook 
(documented in Section 5.10)

mm
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Screw Listing
Phillips PM1.5×3.0 Bluetooth Cover Screw Locations

Table C-8
Phillips PM1.5×3.0 Screw

Color Qty. Length Thread
Head 
Width

Black 2 3.0 mm 1.5 mm 3.5 mm

Where used:
Two screws that secure the Bluetooth board to the Bluetooth cover 
(documented in Section 5.7)

mm
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Screw Listing
P

Torx T8M2.5×9.0 Keyboard Access Screw Locations

Table C-9
Torx T8M2.5×9.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 9.0 mm 2.5 mm 5.0 mm

Where used:
Two screws that secure the keyboard to the notebook 
(documented in Section 5.8)

mm
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Screw Listing
Torx T8M2.5×9.0 Switch Cover Screw Locations

Table C-10
Torx T8M2.5×9.0 Screw

Color Qty. Length Thread
Head 
Width

Black 16 9.0 mm 2.5 mm 5.0 mm

Where used:
Two screws that secure the switch cover to the notebook 
(documented in Section 5.9) 

mm
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Screw Listing
Torx T8M2.5×9.0 Display Assembly Screw Locations

Table C-10
Torx T8M2.5×9.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 16 9.0 mm 2.5 mm 5.0 mm

Where used:
Four screws that secure the display assembly to the notebook 
(documented in Section 5.16)

mm
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Screw Listing
Torx T8M2.5×9.0 Top Cover Screw Locations

Table C-10
Torx T8M2.5×9.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 16 9.0 mm 2.5 mm 5.0 mm

Where used:
Ten screws that secure the top cover to the notebook 
(documented in Section 5.17)

mm
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Screw Listing
Torx T8M2.5×6.0 Fan Assembly Screw Location

Table C-11
Phillips PM2.5×6.0 Screw

Color Qty. Length Thread
Head 
Width

Black 1 6.0 mm 2.5 mm 5.0 mm

Where used:
One screw that secures the fan assembly to the notebook 
(documented in Section 5.13)

mm
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Screw Listing
Phillips M2.5×3.0 Top Cover Screw Locations

Table C-12
Phillips M2.5×3.0 Screw

Color Qty. Length Thread
Head 
Width

Bronze 5 3.0 mm 2.5 mm 4.0 mm

Where used:
Five screws that secure the top cover to the notebook (3 in the MultiBay, 2 in the 
hard drive bay; documented in Section 5.17)

mm
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Screw Listing
Phillips PM1.5x4.0 Speaker Assembly Screw Location

Table C-13
Phillips PM1.5x4.0 Screw

Color Qty. Length Thread
Head 
Width

Black 2 4.0 mm 1.5 mm

Where used:
One screw that secures speaker assembly to the base enclosure 
(documented in Section 5.19)

mm
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Screw Listing
Phillips PM1.5x4.0 LED Board Screw Location

Table C-13
Phillips PM1.5x4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 2 4.0 mm 1.5 mm

Where used:
One screw that secures the LED board to the base enclosure 
(documented in Section 5.20)

mm
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Screw Listing
Phillips PM2.5×11.0 Hard Drive Connector Screw Location

Table C-14
Phillips PM2.5x11.0 Screw

Color Qty. Length Thread
Head 
Width

Black 1 11.0 mm 2.5 mm 5.0 mm

Where used:
One screw that secures the hard drive connector to the system board 
(documented in Section 5.22)

mm
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Screw Listing
Hex M2.5×9.0 System Board Standoff Locations

Table C-15
Hex M2.5×9.0 Standoffs

Color Qty. Length Thread
Head 
Width

Silver 2 9.0 mm 2.5 mm

Where used:
Two standoffs that secure the system board to the notebook 
(documented in Section 5.22)

mm
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Index

1394 connector 1–40
353393-001 5–11

A
AC adapter

spare part number 3–13
specifications 6–7

audio troubleshooting 2–26

B
battery bay, location 1–50
battery bezel

illustrated 3–2, 3–10
removal 5–6

battery light, location 1–47
battery pack

See also MultiBay battery 
pack, spare part number

illustrated 3–9
removal 5–5
spare part numbers 3–9
specifications 6–7, 6–8

battery release latch, 
location 1–50

battery slot, location 1–38

Bluetooth compartment cover
illustrated 3–2, 3–10
removal 5–14

Bluetooth compartment, 
location 1–38, 1–48

Bluetooth wireless 
communications board

removal 5–14
spare part number 5–14

bottom board
illustrated 3–4, 3–6
removal 5–50
spare part number 5–50

bottom components 1–48

C
cables, service 

considerations 4–2
caps lock key, location 1–43
caps lock light, location 1–44
carrying case, spare part 

numbers 3–13
CD-ROM drive

spare part number 3–7, 
3–12

specifications 6–15
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Index
components
bottom 1–48
front 1–37
keyboard 1–41, 1–42
left-side 1–37
rear panel 1–39
right-side 1–39
top 1–44

Computer Setup
Advanced Menu 2–5
File Menu 2–3
overview 2–1
Security Menu 2–4

configuration information 2–8
connector pin assignments

external monitor 
connector A–3

headphone jack A–4
microphone jack A–4
monitor connector A–3
parallel connector A–5
RJ-11 (modem) jack A–2
RJ-45 (network) jack A–1
serial connector A–6
S-Video connector A–3
USB connector A–2

connectors
1394 1–40
power 1–39
service considerations 4–2

cursor control keys, 
location 1–43

D
design overview 1–51
diagnostics

configuration 
information 2–8

test information 2–9
Diagnostics for  

Windows 2–1, 2–8
disassembly sequence 

chart 5–3
diskette drive

OS loading problems 2–24
spare part number 3–7, 

3–12
display assembly

illustrated 3–2
removal 5–35
spare part numbers 3–3, 

5–35
specifications 6–3, 6–4, 

6–5
display hinge cover

illustrated 3–2, 3–10
removal 5–38

display lid switch, 
location 1–45

display release latch, 
location 1–38

DMA specifications 6–16
docking connector, 

location 1–49
drives, preventing damage 4–3
Index–2 Maintenance and Service Guide



Index
DVD+RW/R and CD-RW 
Combo Drive

spare part number 3–7, 
3–12

specifications 6–9
DVD/CD-RW Combo Drive

spare part number 3–7, 
3–12

specifications 6–11
DVD-ROM drive

spare part number 3–7
specifications 6–13

E
electrostatic discharge 4–4, 

4–7
embedded numeric keypad, 

location 1–43
external monitor connector

location 1–40
pin assignments A–3

F
f1 through f12 function keys, 

location 1–43
fan assembly

illustrated 3–4, 3–6
removal 5–27
spare part number 5–27

features 1–33
feet

illustrated 3–10
locations 5–10

flowcharts
initial 

troubleshooting 2–12
no audio (1) 2–26
no audio (2) 2–27
no network/modem 

connection 2–31
no OS loading 2–20
no OS loading, diskette 

drive 2–24
no OS loading,  

HDD (1) 2–21
no OS loading,  

HDD (2) 2–22
no OS loading,  

HDD (3) 2–23
no OS loading,  

optical drive 2–25
no power (1) 2–13
no power (2) 2–14
no power (3) 2–15
no power (4) 2–16
no video (1) 2–17
no video (2) 2–18
nonfunctioning 

device 2–28
nonfunctioning 

keyboard 2–29
nonfunctioning pointing 

device 2–30
nonfunctioning 

Port Replicator 2–19
fn key, location 1–43
front components 1–37
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G
grounding equipment and 

methods 4–6

H
hard drive

disassembly 5–9
illustrated 3–4, 3–6
OS loading problems 2–21
removal 5–7
spare part numbers 3–5, 

3–12, 5–7
specifications 6–6

hard drive bay,  
location 1–40, 1–49

hard drive cover, removal 5–7
hard drive light, location 1–46
hard drive security screw, 

location 1–49
headphone jack

location 1–40
pin assignments A–4

heat sink
illustrated 3–4, 3–6
removal 5–30
spare part number 5–30

I
I/O address specifications 

6–18
infrared port, location 1–38
interrupt specifications 6–17

K
keyboard

illustrated 3–2
removal 5–16
spare part numbers 3–5, 

5–16
troubleshooting 2–29

keyboard components 1–41, 
1–42

keyboard plate
illustrated 3–2, 3–10
removal 5–26

L
LED board

removal 5–48
spare part number 3–9, 

5–48
left-side components 1–37
location 1–40

M
mass storage devices, spare 

part numbers 3–12
memory module

illustrated 3–4, 3–6
removal 5–24
spare part numbers 3–9, 

5–24
memory shield

illustrated 3–2, 3–10
removal 5–24

microphone jack
location 1–40
pin assignments A–4
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Mini PCI communications 
board

removal 5–11
spare part numbers 3–7, 

5–11
Mini PCI compartment cover

illustrated 3–2, 3–10
removal 5–11

Mini PCI compartment, 
location 1–50

Miscellaneous Plastics Kit
components 3–10
spare part number 3–3, 

3–10
model number 3–1
models 1–2
modem board

illustrated 3–4, 3–6
removal 5–22
spare part number 5–22

modem, troubleshooting 2–31
monitor connector

location 1–40
pin assignments A–3

mouse, spare part 
number 3–14

MultiBay battery pack, spare 
part number 3–7, 3–12

MultiBay device
location 1–40, 1–49
spare part numbers 3–12

MultiBay light, location 1–46

MultiBay release latch, 
location 1–49

mute button,  
location 1–38

N
network, troubleshooting 2–31
nonfunctioning device, 

troubleshooting 2–19, 2–28
notebook feet

illustrated 3–10
locations 5–10

notebook specifications 6–1
num lock key, location 1–43
num lock light, location 1–44
numeric keypad, location 1–43

O
operating system loading, 

troubleshooting 2–20
optical drive, spare part 

numbers 3–7

P
packing precautions 4–4
parallel connector

location 1–39
pin assignments A–5

password, clearing 1–35
PC Card eject buttons, 

location 1–38
PC Card slot space saver, 

illustrated 3–10
PC Card slots, location 1–38
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plastic parts 4–2
pointing device, 

troubleshooting 2–30
Port Replicator

spare part numbers 3–13
troubleshooting 2–19

power button,  
location 1–45

power connector,  
location 1–39

power cord, spare part 
numbers 3–13

power management 
features 1–36

power, troubleshooting 2–13
power/Standby light, 

location 1–47
Presentation Mode button, 

location 1–46
processor

illustrated 3–4, 3–6
removal 5–33
spare part numbers 5–33

Q
QuickLock button, location 

1–45

R
real time clock battery

illustrated 3–2, 3–10
removal 5–43

rear panel components 1–39
removal

preliminaries 4–1
procedures 5–1

replacement
preliminaries 4–1
procedures 5–1

right-side components 1–39
RJ-11 (modem) jack

location 1–38
pin assignments A–2

RJ-45 (network) jack
location 1–40
pin assignments A–1

RTC battery
illustrated 3–2, 3–10
removal 5–43

S
Screw Kit, spare part 

number 3–14
scroll lock light, location 1–44
Secure Digital (SD) Card slot, 

location 1–38
security cable slot, 

location 1–38
security card, spare part 

number 3–14
serial connector

location 1–39
pin assignments A–6

serial number 3–1, 5–2
service considerations 4–2
specifications

AC adapter 6–7
battery pack 6–7, 6–8
CD-ROM drive 6–15
display 6–3, 6–4, 6–5
DMA 6–16
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DVD+RW/R and CD-RW 
Combo Drive 6–9

DVD/CD-RW Combo 
Drive 6–11

DVD-ROM drive 6–13
hard drive 6–6
I/O addresses 6–18
interrupts 6–17
notebook 6–1

static shielding materials 4–7
stereo speakers, location 1–38
S-Video connector

location 1–40
pin assignments A–3

switch cover
illustrated 3–2
removal 5–20
spare part number 5–20

system board
removal 5–52
spare part numbers 5–52

T
thermal grease, replacement 

5–32
tools required 4–1
top components 1–44, 1–46
top cover

illustrated 3–4, 3–6
removal 5–39
spare part number 5–39

TouchPad buttons, 
location 1–46

TouchPad, location 1–46

transporting precautions 4–4
troubleshooting

audio 2–26
Computer Setup 2–2
Diagnostics for 

Windows 2–8
keyboard 2–29
modem 2–31
network 2–31
nonfunctioning 

device 2–19, 2–28
operating system 

loading 2–20
overview 2–1
pointing device 2–30
Port Replicator 2–19
power 2–13
video 2–17

troubleshooting 
flowcharts 2–11

U
Universal Serial Bus connector

location 1–40
pin assignments A–2

Universal Serial Bus mouse, 
spare part number 3–14

V
vents, location 1–39, 1–48
video troubleshooting 2–17
volume control buttons, 

location 1–38
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W
Windows applications key, 

location 1–43
Windows logo key, 

location 1–43
wireless LAN card

removal 5–11
spare part numbers 3–7, 

5–11
wireless on/off button, 

location 1–45
wireless on/off light, 

location 1–47
workstation precautions 4–5
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